Velocity 3.1 R3 Installation Guide

MAN004-0811, August, 2011

Version 3.1 R3

Copyright© 2011 Hirsch Electronics LLC. All rights reserved. ScramblePad® and ScrambleProx® are registered trademarks of Hirsch Electronics. DIGI**TRAC™, MATCH™, ScrambleCard™, SCRAMBLE*NET™ (abbreviated S*NET), X*NET, and Velocity™ are all trademarks of Hirsch Electronics.

Microsoft, MS and MS-DOS are registered trademarks, and Windows, Windows Server 2003, Windows 2008, Windows XP, and Windows Vista are trademarks of Microsoft Corporation.

Velocity systems are suitable for use over private (intranet) and public (internet) data networks when configured to use an encryption method including an Authentication Header and an algorithm capable of Triple-DES or better that is NIST certified. The encryption must be provided using Listed (NWQG) Lantronix Model SecureBox SDS1100 encryption modules and Listed (EPBU) Ever Glow Electronic Co., Ltd., Model DCU120030 plug-in transformers.

The National Institute of Standards and Technology (NIST) has awarded Velocity 3.0 AES Certificate #482.
Getting Help

If you encounter a problem that is not discussed in this guide and you need technical support, do the following:

1. Contact your local dealer or the provider of this product.
2. If your dealer is not available, contact Hirsch Technical Support directly. This can be done in a number of ways:
   - Mail: Hirsch Electronics
     1900-B Carnegie Avenue
     Santa Ana, CA 92705-5520
     Attn: Technical Services
   - Phone: 877-HIRSCHX (877-447-7249) toll-free
   - Fax: (949) 250-7362
   - Email: support@HirschElectronics.com

Whenever you call your local dealer or Hirsch, be sure to have your registration material, serial number and software version number available.

For future reference, record these numbers here.

Serial Number: _________________________________
Version Number: ________________________________
Dealer:  ________________________________________
Dealer Phone #:  ________________________________
CCM Rev/Version #:  ______________________________
UL Requirements

The following UL issues are addressed here:

GENERAL

1. UL terms that are applicable to this application can be found “Glossary” on page 283 of the Velocity Operators Guide (MAN007).
2. The UL Listed Velocity System is comprised of the following: Central Supervisory Station, XBox, M1N, M2, M8, M16, DS37LH, DS47L, DS47L-HI, DS47L-SPX, Power Limitation Board, PS2, DTLM1, DTLM2, DTLM3, MELM1, MELM2, and MELM3. The M2, M8, and M16 may employ the following expansion boards: MEB/BE, AEB8, REB8, and SNIB.

VELOCITY

1. If Alarm Priority levels are assigned by user, then priority must be assigned as follows for UL applications:
   a. Fire alarm and industrial supervision where a risk of injury to persons, or damage or destruction of property may be involved.
   b. Hold-up or panic alarm.
   c. Burglar alarm.
   d. Watchman tour.
   e. Fire-alarm supervision.
   f. Burglar-alarm supervision.
   g. Industrial supervision where a risk of injury to persons, or damage or destruction of property will not be involved.
   h. Other supervisory services.
   Items (b) and (c) may have equal priority. Items (e) and (f) may have equal priority. Items (g) and (h) may have equal priority.
2. Alarm Stacking feature is not to be used for UL applications.
3. Return to Normal feature is not to be used for UL applications.
4. Video capability of Velocity 3.1 software has not been evaluated by UL.

CENTRAL SUPERVISORY STATION

1. See the introduction to the Velocity Installation Guide (MAN004) for the minimum hardware and software requirements of the central supervisory station equipment.
2. The data processing equipment and office appliance equipment used as central supervisory station equipment shall be Listed under Office Appliances and Business Equipment (UL 114) or Information Processing and Business Equipment (UL 478) or Information Technology Equipment (UL 60950).

3. A redundant server configuration must be employed where the servers and workstations are networked via a dedicated Ethernet LAN. The network interfaces the protected premise units through an Xbox with a serial to Ethernet converter or a SNIB2.

4. The Map Builder function must be employed to display the state and condition of all alarm points of the system.

5. A “panel logged off” event may be a compromise attempt on the system.

6. Supply line transient protection complying with the Standard for Transient Voltage Surge Suppressors, UL 1449, with a maximum marked rating of 330 V shall be used on Central Monitoring Station Equipment.

7. If the Xbox is not installed in the Central Monitoring Station, signal line transient protection complying with the Standard for Protectors for Data communications and Fire Alarm Circuits (UL 497B) with maximum marked rating of 50 V shall be used on communication circuits extending beyond 50 feet from the computing systems.

8. The Central Monitoring Station Equipment shall be installed in a temperature-controlled environment. A temperature-controlled environment is defined as one that can be maintained between 13–35°C (55–95°F) by the HVAC system. Twenty-four hours of standby power shall be provided for the HVAC system. The standby power for the HVAC system may be supplied by an engine-driven generator alone. A standby battery is not required to be used.

9. In addition to the main power supply and secondary power supply that are required to be provided at the central supervisory station, the system shall be provided with an uninterruptible power supply (UPS) with sufficient capacity to operate the computer equipment for a minimum of 15 minutes. If more than 15 minutes is required for secondary power supply to supply the UPS input power, the UPS shall be capable of providing input power for at least that amount of time.

10. The UPS shall comply with the Standard for Uninterruptible Power Supply Equipment (UL 1778) or the Standard for Fire Protective signaling Devices (UL 1481).

11. In order to perform maintenance and repair service, a means for disconnecting the input to the UPS while maintaining continuity of power to the automation system shall be provided.
12. The alarm system’s network settings shall be designed such that the maximum time lapse from the initiation of an initiating device circuit until it is annunciated at the central supervising station shall not exceed 90 seconds.

13. The alarm system’s network settings shall be designed such that the maximum time for the central supervising station to annunciate a single break, single ground, wire-to-wire short, loss of signal, or any combination of these shall not exceed 200 seconds.

14. The alarm system configuration shall be designed such that the number of signals on a single channel shall be limited to 1000.

**XBOX**

1. XBox configuration and installation are addressed in “XBox Installation,” of the Hirsch DIGI*TRAC Design and Installation Guide (MAN001).
2. UL has not verified the XBox hookup for a remote dialup controller or the modem loop configuration.
3. The alarm relay contact is rated 24 VDC, 2 A, resistive.
4. Wiring to the RS-232 circuit is limited to the same room (50 feet).
5. Shielded cable must be used on the RS-232 circuit.

**M1N**

1. Input rating of the M1N is 120 VAC, 50/60 Hz, 500 mA.
2. The Alarm/Control Relay contact rating is 24 VDC, 1 A, resistive.
3. The M1N shall not employ a secondary battery.

**M2**

1. UL has verified compatibility of the Hirsch DS37L, DS37LH, DS47L, DS47L-HI, DS47L-SPX, and DS47L-HI-SPX with the M2.
2. The Alarm/Control Relay contact rating is 24 VDC, 1 A, resistive.

**M8**

1. UL has verified compatibility of the Hirsch DS37L, DS37LH, DS47L, DS47L-HI, DS47L-SPX, and DS47L-HI-SPX with the M8.
2. The Alarm/Control Relay contact rating is 24 VDC, 1 A, resistive.

**M16**

1. Input rating of the M16 is 120 VAC, 50/60 Hz, 1A.
2. UL has verified compatibility of the Hirsch DS47L-SPX with the M16.
3. The Alarm/Control Relay contact rating is 24 VDC, 1 A, resistive.
# Contents

Getting Help ................................................................................................................ iii
UL Requirements .............................................................................................................. iv

Introduction ...................................................................................................................... 1
   How to Proceed .............................................................................................................. 3

Installation ....................................................................................................................... 5
   Preliminary ..................................................................................................................... 7
      Minimum Hardware Requirements ............................................................................. 7
      Software Requirements .............................................................................................. 9
   Installing the Operating Systems .................................................................................. 12
      Installing Windows Server 2008 R2 ....................................................................... 13
         Configuring for .NET Frameworks Usage ............................................................ 18
         Enabling Network Discovery ............................................................................... 19
      Installing Windows Server 2003 .............................................................................. 20
      Installing Windows Server 2003 Service Pack ..................................................... 28
      Installing Windows XP, Windows Vista, or Windows 7 ........................................... 28
      Turning Off Windows Firewall ............................................................................... 31
   SQL Server Installation .............................................................................................. 32
      Limitations of SQL Server 2008 R2 Express ............................................................ 32
      Installing SQL Server 2008 ..................................................................................... 33
      Installing SQL Server 2005 ..................................................................................... 36
         Setting Up SQL Server User Accounts ................................................................. 37
   Velocity Installation ................................................................................................... 40
      Preliminary Recommendations ............................................................................... 40
      Installing Velocity ................................................................................................... 41
         Installing Velocity on Windows Server 2008 R2 with SQL Server 2008 ........ 43
         Installing Velocity on Windows 2003 Server with SQL 2005 ......................... 55
Installing Velocity on Windows XP SP3, Vista, or Windows 7 71
Turning On Windows Firewall .........................................................85
Configuring Windows Firewall..................................................85
Assigning a TCP/IP Port Number to the SQL
Server Database Engine.................................................87
Starting an Instance of SQL Server (SQL Server
Configuration Manager) ................................................88
Starting Velocity ......................................................................................89
What’s Next .............................................................................................90

How Do I... ..........................................................................................93

Installing Video Boards .....................................................................97
Installing the Spectrim Lite Software.............................................98
Installing the Spectrim Lite Board...........................................................99

Signature Capture Devices....................................................................103
Installing the Capture Device ..............................................................104
Configuring Velocity for Capture Devices ............................................107

Card Scanners ..................................................................................109

Smart Card Readers ........................................................................111

Installing CCTV Matrix Switchers ................................................113

Installing Digital Cameras ..............................................................117
Network Cameras ..............................................................................118
Equipment Required ........................................................................118
Installation Procedure ...................................................................118
Installing the Audio Module ..............................................................118
Configuring the Camera for Velocity .............................................119

Installing DVRs ................................................................................125
Installation Procedure ........................................................................126
Connecting the DVR ......................................................................126
Configuring the DVR ......................................................................127
Multi-Language Applications .................................................................129

Upgrading CCMs ..................................................................................131
  Replacing Existing CCMs .................................................................132

Installing Printers ...............................................................................137
  Installing Printers ............................................................................138
    Rio and Tango Badge Printers ......................................................138
    Eltron Badge Printers .................................................................138
    Reporting/Logging Printers ...........................................................138
  Configuring Printers ........................................................................139
    Configuring MagiCard and Log Printers ......................................139
    Adjusting Badge Printers for Badge Thickness .........................142
    Configuring the Eltron P420 Badge Printer .................................142

Configuring Device Servers ...............................................................145
  Digi One SP ......................................................................................146
    Prerequisites for the Digi One SP ..............................................146
    Connecting the Digi One SP .......................................................147
    Configuring the Digi One SP .......................................................148
  Digi PortServer TS 16 .......................................................................157
    Connecting PortServer TS 16 ......................................................158
    Configuring PortServer TS 16 ......................................................158
  Cable Pin-outs ................................................................................168
    DB9 to RS-232/RS-485 Cable Pin-outs .......................................168
    RJ-45 to DB9 Cable Pin-outs ......................................................170

Connecting an Enrollment Station ......................................................171
  Connecting an Enrollment Station ..................................................172
  Testing Enrollment Station Connectivity ......................................172

Fire Alarm Systems ............................................................................175
  Installation Procedure .....................................................................177
    Connecting the Fire Alarm System to Velocity .........................177
    Configuring Fire Alarm System for Velocity ..............................178
Velocity Update Wizards

Velocity 2.5 SP1A to 2.6 Upgrade Wizard ................................. 181
  Upgrading Velocity 2.6 to Velocity 2.6 SP2 .............................. 183
Velocity 2.0b to 2.5 Upgrade Wizard ........................................ 184
  Velocity 2.0b to 2.5 Upgrade Preliminaries ............................ 184
  Upgrading from Velocity 2.0b to 2.5 ....................................... 185
Upgrading to Velocity 3.1 R3 ....................................................... 190
  Upgrading Velocity 2.6 SP2 to Velocity 3.1 R3 ....................... 190
  Upgrading Velocity 2.6 SP2 to Velocity 3.1 R2 ....................... 191
  Upgrading Velocity 3.0 to Velocity 3.1 R3 .............................. 196

Modem Setups for Dial-Up .......................................................... 199

  Connecting the Modems .......................................................... 200
  Modem Setup on Windows ....................................................... 201
    Configuring Modems using HyperTerminal ........................... 202
      Configuring MultiTech Modems ........................................ 203
      Configuring Zoom 14.4 Pocket Modems ............................ 204
  Modem Setup on Velocity ........................................................ 205
Introduction

Velocity 3.1 R3 is the latest version of Hirsch’s access control and security management program. The program was designed from the beginning to utilize Hirsch DIGI*TRAC controllers containing the Command and Control Module (CCM) Version 7.4.31 or later.

Velocity 3.1 R3 can run on any of these operating systems:

- Windows Server 2003 or Windows Server 2008 R2 (Velocity server or standalone workstation)
- Windows XP (Velocity client or standalone workstation)
- Windows Vista (Velocity client or standalone workstation)
- Windows 7 (Velocity client or standalone workstation)

If you are using Windows Server 2003, Windows Server 2008 R2, or a standalone system using Windows XP, Windows Vista, or Windows 7, the Velocity database can use SQL Server 2008 Express. SQL Server 2008 Express is included on the Velocity DVD and is installed automatically as part of the Velocity install routine.

If you already have SQL Server 2005, 2008, or 2008 R2 installed on your server, Velocity detects and uses the full version of SQL Server instead of express version for the Velocity database. For more on Windows and SQL Server compatibilities, refer to the table on page 6.

The purpose of this manual is to make your first experience with Velocity 3.1 R3 as simple as possible. This manual only covers basic hardware configuration guidelines and initial software installation procedures.

+ Instructions for operating Velocity are contained in the online help file which is available once you’ve actually installed and opened Velocity.
This manual covers these basic topics:

- Hardware and software requirements — see “Minimum Hardware Requirements” starting on page 7.
- Installing all supported Windows operating systems — see “Installing the Operating Systems” starting on page 12.
- Installing Velocity 3.1 R3 software — see “Velocity Installation” starting on page 40.
- Starting Velocity — see “Starting Velocity” starting on page 89.
- Installing and configuring video boards for photo capture — see “Installing Video Boards” on page 97.
- Installing signature capture devices for signature capture — see “Signature Capture Devices” on page 103.
- Connecting a CCTV system to the workstation — see “Installing CCTV Matrix Switchers” on page 113.
- Connecting a digital camera to the Velocity network — see “Installing Digital Cameras” starting on page 117.
- Connecting a DVR to the Velocity network — see “Installing DVRs” starting on page 125.
- Installing and using multiple monitors — see “Installing Multiple Monitors” starting on page 129.
- Installing multiple language capabilities — see “Multi-Language Applications” starting on page 129.
- Upgrading controllers to CCM 7.4.31 — see “Upgrading CCMs” starting on page 131.
- Installing and configuring badge printers — see “Installing Printers” starting on page 137.
- Connecting and configuring device servers for this system — see “Configuring Device Servers” starting on page 145.
- Connecting and configuring an Enrollment Station — see “Connecting an Enrollment Station” starting on page 171.
- Connecting and configuring a Fire Alarm system for monitoring by Velocity — see “Fire Alarm Systems” starting on page 175.
- Upgrading Velocity from earlier versions to Velocity 3.1 R3 using the available Velocity update wizards — see “Velocity Update Wizards” starting on page 179.
• Setting up dial-up modems for Velocity dial-up support — see “Modem Setups for Dial-Up” on page 199.

For information on configuring and using Velocity, refer to Velocity on-line help. For more on this, see “How Do I...” starting on page 93.

How to Proceed

The order in which these subjects appears does not imply the order in which you should actually undertake them. Some of these tasks you’ll need to do while others you won’t.

To save time and complications, basic hardware should be installed, connected, and configured before you actually install and configure Velocity. This includes printers, video capture board, device servers, enrollment station, modem, multiple monitors, CCTV, and the serial and parallel ports to support them.
Installation

Velocity 3.1 R3 is easy to install. Just follow these steps to get started:

1. Make sure you have the required hardware and software on your computer(s) as described in “Preliminary” on page 7.

2. If not already done, install the operating system—Windows Server 2003, Windows Server 2008 R2, Windows XP Professional, Vista, or Windows 7 — and their respective service packs. For more on this, refer to the section starting on page 12.

The type of Windows operating system you install depends on what type of role each computer on your network will take.

### Use: For:

| • Windows Server 2008 R2 64 bit Standard or Enterprise Edition | • Server (allows client connections) |
| • Windows Server 2003 SP2 32 or 64 bit Standard or Enterprise Edition | • Standalone workstation (on a domain) |
| • Windows XP SP3 32 or 64 bit Professional Edition | • Standalone workstation (on a work group) |
| • Windows Vista SP2 32 or 64 bit Business or Ultimate Edition | • Client (connects to a server) |
| • Windows 7 SP1 32 or 64 bit Professional, Ultimate, or Enterprise Edition | • Standalone workstation (on a domain or workgroup) |

3. Install SQL Server. See “Software Requirements” on page 9 for supported versions.

4. Install Velocity as explained in “Velocity Installation,” starting on page 40.
You must install CCM version 7.4.31 or later into each controller before your security system can use Velocity 3.1 R3. For more on installing the new CCM into your controller, see “Upgrading CCMs” on page 131 of the Velocity 3.1 Installation Guide.
**Preliminary**

Before installing Velocity, make sure your server or client computer meets these requirements.

**Minimum Hardware Requirements**

- **Processor:** Pentium 4 with 2 GHz or higher
- **Memory:** 4 GB or more of RAM
- **Hard Drive:** 250 GB or higher for server or workstation
  100 GB or higher for client
- **Other:** DVD-ROM drive (DVD-R), monitor, keyboard, mouse or other pointing device

The following components may be required dependent on your installation configuration and application usage:

- Video card (256 MB video RAM minimum) when using Velocity Graphics or Badging functions. NOTE: For optimum video performance, 1GB Video RAM or more may be required
- 1 serial port (or USB-to-COM port adapter) for each of the following:
  - Hardwired channel of controllers
  - Enrollment station for cards
  - Modem (if connecting to a controller via modem)
  - CCTV matrix switcher controls
- 1 USB or parallel port for each of the following:
  - Badge printer
  - Report printer
  - Alarm/Event printer
  - Parallel multi-port adapter (for multiple printers available through Hirsch)
- Network interface card (NIC)
- Sound card (recommended for tutorials & alarms)
- DVD/CD-RW, USB drive, or other mass storage back up
- Video capture card (to receive video from CCTV matrix switcher if required)
**Hint:** A CD-RW or DVD-RW drive, more RAM, faster processor, and faster video card with more video RAM are recommended and will improve performance for most applications; it will also help ensure long-term compatibility with system expansion and upgrades to Velocity, the Windows operating system, and database.

These system requirements are Hirsch’s estimation of what will be required for satisfactory performance; however, your particular needs may differ or exceed the requirements noted. Your specific needs are dependent on several factors including number of users on the system, applications running, connected devices, and level of usage. Therefore, please follow this general guideline: ensure you have enough processing power, RAM (including video card RAM) and hard disk space in your system to adequately address ALL your applications and services. Then, going forward, please ensure your system performance keeps up-to-date with any expanding requirements.
Software Requirements

- Windows® operating system
- Hirsch Velocity® version 3.1 R3 installation DVD
- Microsoft® SQL Server database
- DIGI*TRAC Controller CCM Version 7.4.31 or later

The following chart identifies compatibility required between versions of Windows and SQL Server database programs:

<table>
<thead>
<tr>
<th>Velocity Mode</th>
<th>Operating System</th>
<th>Database</th>
</tr>
</thead>
</table>
| Server (Option 1) | Windows Server 2008 R2 64 bit, Standard or Enterprise Edition | - SQL Server 2008 R2 64 bit Standard, Workgroup or Enterprise Edition with SP1  
- SQL Server 2008 R2 64 bit Express (included on disk) |
| Server (Option 2) | Windows Server 2003 SP2 32 or 64 bit Standard or Enterprise Edition | - SQL Server 2005 SP4 32 or 64 bit, Workgroup, Standard, or Enterprise Editions  
- SQL Server 2008 R2 Express Edition (included on disk) |
Velocity 3.1 R3 Installation Guide

<table>
<thead>
<tr>
<th>Velocity Mode</th>
<th>Operating System</th>
<th>Database</th>
</tr>
</thead>
</table>
| Single-user Workstation| • Windows XP SP3 32 or 64 bit Professional Edition  
                             • Windows Vista SP2 32 or 64 bit Business or Ultimate Edition  
                             • Windows 7 SP1 32 or 64 bit Professional, Ultimate or Enterprise Edition | SQL Server 2008 R2 Express (included on disk) |
| Client                 | • Windows XP SP3 32 or 64 bit Professional Edition  
                             • Windows Vista SP2 32 or 64 bit Business or Ultimate Edition  
                             • Windows 7 SP1 32 or 64 bit Professional, Ultimate, or Enterprise Edition | Not applicable; connects to Velocity Server for its database |

Velocity 3.1 R3 is not backwards compatible. It does not work with SQL Server 7.0, SQL Server 2000, or MSDE.

+ **If you install Windows Server 2008 R2, you must also install SQL Server 2008 SP1.**
Once you have satisfied these prerequisites, install your selected operating system and Velocity as required by your facility. Use the following flowchart to help you during the installation process.

1. **Velocity Server**
   - Install Windows Server 2003
     - Page 20
   - Configure Windows Server 2003
     - Page 20
   - Install Windows Server 2008 R2
     - Page 13
   - Configure Windows Server 2008 R2
     - Page 18
   - Install SQL Server 2005 (optional)
     - Page 36
   - Install SQL Server 2008 (optional)
     - Page 33

2. **Velocity Client**
   - Install Windows XP, Vista, or Windows 7
     - Page 28
   - Configure Windows XP, Vista, or 7
     - Page 89
   - Register Velocity
   - Start Velocity
     - Page 89
   - Install Service Pack (if needed)
   - Install Velocity Version 3.1 R3
     - Page 40

3. **Velocity Standalone Workstation**
   - Install Windows XP, Vista, or Windows 7
     - Page 28
   - Configure Windows XP, Vista, or 7
     - Page 89
   - Register Velocity
   - Start Velocity
     - Page 89
   - Install Service Pack (if needed)
   - Install Velocity Version 3.1 R3
     - Page 40
Installing the Operating Systems

This section covers the installation and initial configuration of Windows Server 2003 or Windows 2008 R2— for a server with multiple clients — as well as Windows XP, Windows Vista, or Windows 7 — for clients and standalone workstations.

We assume throughout this installation process that you are setting up your Windows operating system on a dedicated security network, since this is the arrangement most customers use. However, some customers need to install Velocity on a shared network. If this is the case, several of the assumptions made in the following sections do not apply. In general, use this flowchart to identify your options:
Installing Windows Server 2008 R2

The quickest path to installing Windows Server 2008 R2 is to read the Quick Start and Getting Started guides that come with the Windows Server 2008 R2 software as well as the release notes located in the root directory of the Windows Server 2008 R2 CD or DVD. Follow the prompts that appear on the screen during the installation process.

However, Windows Server 2008 R2 is a complex program and often requires knowledge not only of your computer but also of the network it will control. For this reason, consider preparing yourself for any eventuality by purchasing one of the many books on Windows Server 2008 available from your local bookstore. (Several of the best are Microsoft publications.)

To install Windows Server 2008 R2:

1. Turn on your system.
2. Insert the Windows Server 2008 R2 DVD into your DVD drive.
3. Restart the system.
   
   To restart the system, press Ctrl + Alt + Del or turn off the system once, and then turn it on again.

   + When prompted to press any key to boot from DVD, press Enter while the message is displayed. If the Windows installation screen (shown in step 4) does not appear, turn off the system, then turn it on again.
The DVD drive starts. A screen like this appears:

4. Press any key.
   The computer boots up and setup loads from the DVD. The graphic interface appears.

5. Plug the USB drive into your target box's USB slot or your DVD disc into your DVD drive and boot the box.
   The target system must be able to boot from DVD or USB devices to perform an installation. The system boots into the new Windows boot screen, as shown in this example:
After a few moments, the Windows Server 2008 localization screen appears.

6. Perform the following operations:

<table>
<thead>
<tr>
<th>For this question:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server localization</td>
<td>Select a language with other option then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Install Windows</td>
<td>Click <strong>Install Now</strong>.</td>
</tr>
<tr>
<td>Do you want to enter your product key?</td>
<td>Click <strong>Yes</strong>.</td>
</tr>
<tr>
<td>Type your product key for activation</td>
<td>Type the product key then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Terms</td>
<td>Check &quot;I accept the license terms&quot; box then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Which type of installation do you want?</td>
<td>Select <strong>Custom (Advanced)</strong>.</td>
</tr>
<tr>
<td>Where do you want to install Windows?</td>
<td>Click to select the first disk, usually Disk 0, then click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
The first time you log onto the computer, Windows creates your profile.

<table>
<thead>
<tr>
<th>For this question:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Windows</td>
<td>This should take 20 minutes or more. Once this is finished, the installer automatically reboots the computer and the new desktop appears.</td>
</tr>
<tr>
<td>User’s password must be changed</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter and confirm a new password then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Your password has been changed</td>
<td>Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
Once this is complete, your desktop will load and the Initial Configuration Tasks wizard appears like this screen:

![Initial Configuration Tasks wizard](image)

Once the Initial Configuration Tasks wizard appears, follow those instructions.

7. Use the Initial Configuration Tasks wizard to provide computer information, such as time zone, network configuration, and computer name.

8. When you close the Initial Configuration Tasks wizard, your desktop is displayed like this example:

![Desktop example](image)
The server reboots. When Windows returns, a screen like this appears:

9. Press **CTRL + ALT + DEL** to log in.
   The password screen appears.
10. Enter your new password then click **OK**.
    Windows desktop now appears.

+ *We recommend that you install all relevant Windows updates at this time. Simply go to the Microsoft website, download all applicable updates, then install them as required.*

**Configuring for .NET Frameworks Usage**

If you are using Windows 2008 R2 as your platform for Velocity 3.1 R3, you must now specify the use of .NET Frameworks 3.5.1 features.

To do this:

1. At the Windows 2008 R2 desktop, select **Start > All Programs > Administrative Tools > Server Manager**.
   Server Manager starts.
2. In Server Manager, select the **Features** node and click **Add Features** to start the Add Features Wizard.
3. Follow these steps:

<table>
<thead>
<tr>
<th>At this page:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Features</td>
<td>Check '.NET Frameworks 3.5.1 Features' then click Next.</td>
</tr>
<tr>
<td>Add Roles...</td>
<td>Click the Add Required Role Services button.</td>
</tr>
<tr>
<td>Web Server (IIS)</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Select Role Services</td>
<td>Make sure the '.NET Extensibility' box is checked then click Next.</td>
</tr>
<tr>
<td>Confirm Installation</td>
<td>Click Install.</td>
</tr>
<tr>
<td>Selections</td>
<td></td>
</tr>
<tr>
<td>Installation Complete</td>
<td>Click Close.</td>
</tr>
</tbody>
</table>

Windows 2008 R2 is now ready for the inclusion of the version of .NET Frameworks supported by Velocity 3.1 R3.

**Enabling Network Discovery**

Before installing Velocity on a client PC, you must enable network discovery on your server. This will allow your Velocity Clients to find and communicate with the Velocity Server.

*Network Discovery requires the following services to be started: DNS Client, Function Discovery Resource Publication, SSDP Discovery, and UPnP Device Host. Network discovery must also be able to communicate through Windows Firewall and other network firewalls.*

**To enable Network Discovery:**

1. In Control Panel, open Network and Internet, click Network and Sharing Center, then click Change advanced sharing settings.
2. Click Turn on network discovery under the domain Network Discovery options.
3. Click Save Changes.
Installing Windows Server 2003

The quickest path to installing Windows Server 2003 is to read the Quick Start and Getting Started guides that come with the Windows Server 2003 software as well as the release notes located in the root directory of the Windows Server 2003 CD-ROM. Follow the prompts that appear on the screen during the installation process.

However, Windows Server 2003 is a complex program and often requires knowledge not only of your computer but also of the network it will control. For this reason, consider preparing yourself for any eventuality by purchasing one of the many books on Windows Server 2003 available from your local bookstore. (Several of the best are Microsoft publications.)

Before beginning the installation process, back up all files on the selected PC. This installation process reformats your computer and deletes all files in the process.

The following installation procedure presupposes that you have elected to completely reformat your machine’s hard drive. Upgrading from a previous version of Windows can create unexpected problems.

Hirsch recommends that you perform a clean installation as described in this section, since this reformats and defragments the hard drive, eliminates any unwanted files or programs, and prepares a clean platform for Velocity.

The installation process consists of two steps:

- Setup—the installer prepares the PC for Windows Server 2003 by formatting and partitioning the drive then transferring files from the DVD to the hard drive.
- Configuration—installs and configures Windows Server 2003 by defining the role, address, and other values for the server.

This process takes approximately 45 – 50 minutes depending on the PC. Make sure your PC enables you to boot from the DVD drive on startup. Many computers provide you with a key you can press during reboot or startup that accesses the DVD drive.
If your computer does not provide a bootable DVD drive as a default selection, do this:

1. Reboot the PC and access the BIOS.
   Typically, this requires you to hold down the F2 key as soon as
   the PC powers on, until the BIOS setup screen appears.
2. Set the BIOS to boot from the DVD drive as a first choice. Select
   NONE as the second and third choices.
3. Save changes to the BIOS and exit.

Once you've finished this installation, you can return to the BIOS and set the reboot order to its default.

Windows Server 2003 will not install properly
unless a network or hub is connected to the
server's network interface card (NIC).

To install Windows Server 2003, follow these instructions:

1. Insert the Windows Server 2003 DVD into your DVD drive.
2. Reboot the server.
   A prompt appears asking you to press any key to boot from the
   DVD.
3. Press any key to boot from the DVD.
   The Windows Server 2003 Setup screen appears. It performs
   detection and loads files, then brings up the 'Welcome to Setup'
   screen.
4. Press Enter and follow the dialog boxes and associated
   questions on your screen in this way:

   **For this question:**  **Do this:**
   Licensing Agreement  Press F8 (I agree).
   Repair or No Repair  Press Esc for no repair.
   If you are doing a clean install, this
   message won’t appear.
22 Installing the Operating Systems

5. Let the machine reboot to its C: drive.
   If required, once the system reboots, enter the BIOS and reconfigure the boot sequence as needed.

+ **If you see a message prompting you to start from the DVD, ignore it. The program should automatically boot from the hard disk.**

Several screens, including the Splash screen, appear for which there are no actions.

6. Follow the screens in this way:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regional and Language Settings</td>
<td>Click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
### At this screen: Do this:

<table>
<thead>
<tr>
<th><strong>Personalize Your Software</strong></th>
<th>Enter the name of the end user and his/her organization name. Click <strong>Next</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Key</strong></td>
<td>Enter the 25-character product key number located on the yellow sticker on the back of your Windows CD folder, then click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
| **Licensing Modes**          | Accept the "Per Server. Number of concurrent connections:" option and specify the number of connections you bought. Click **Next**.  
*Note: If you purchase more connections later, you can always add them through Windows Control Panel.* |
| **Computer Name and Administrator Password** | At the ‘Computer Name’ field, enter the computer name you need, such as VELOCITYSERVER. Do not include spaces.  
At the Administrator Password field, enter a password. This password must include a combination of numbers, special characters, and both upper- and lower-case letters, such as the example: **HIRSCH123!**. Remember, this can be changed at any time once you’ve completed the installation.  
Enter the password again in the ‘Confirm Password’ field.  
Click **Next**.  |
| **Setup message**            | If the installer doesn't consider your password strong enough, it displays a message. Click **No** to return to the previous screen and enter a more secure password then click **OK** again.  |

*It is very important that you remember the password and keep it safe.*

*If you are satisfied with your current password, ignore this warning by clicking Yes and continue.*
### At this screen: Do this:

<table>
<thead>
<tr>
<th>Screen</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modem Dialing Information</td>
<td>This screen only appears if you have a modem installed on this machine. Enter values as required. Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Date and Time Settings</td>
<td>Set the correct date, time, time zone, etc. as needed, then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Networking Settings</td>
<td>Select the 'Custom Settings' radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Networking Components</td>
<td>Click to highlight <strong>Internet Protocol (TCP/IP)</strong> then click <strong>Properties</strong>.</td>
</tr>
</tbody>
</table>
| Internet Protocol (TCP/IP) Properties     | 1. Select 'Use the following IP address' radio button. The three fields beneath it are activated.  
                                        | 2. At the IP Address field, specify the IP address for this server. We recommend:  
                                        | 10.1.1.1  
                                        | 3. At the subnet mask field, specify the subnet mask value for this server. We recommend:  
                                        | 255.0.0.0  
                                        | 4. Leave the 'Default Gateway' blank.  
                                        | 5. Leave the DNS fields blank. We'll change these later in Active Directory.  
                                        | 6. Click **Next**. |

**If you don't know the proper IP address and subnet mask values for your system, consult your network administrator.**

**Don't be distracted by the use of the WORKGROUP name. No domain exists yet. We will define a domain name in a few minutes.**

**Workgroup or Computer Domain**

Click **Next** to accept the default 'No, this computer is not on a network...' radio button.

The installer copies files from the CD. This will take a few minutes.

The computer reboots automatically. If asked to boot from a CD, ignore it.
The Windows Server 2003 desktop appears. The Manage Your Server screen appears like this example:

7. Once the Windows Server 2003 desktop reappears, add Active Directory by doing this:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Your Server</td>
<td>Click Add or remove a role.</td>
</tr>
<tr>
<td>Preliminary Steps</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Configure Options</td>
<td>Select Custom Configuration and click Next.</td>
</tr>
</tbody>
</table>

Note:
All screen examples shown in this manual represent their appearance as of the date of this manual. The appearance of these screens may change when the programs associated with them are updated.
## Server Role Select

**Domain Controller (Active Directory)** and click **Next**.

## Summary of Selections

Click **Next**.

## Welcome to Active Directory Installation Wizard

Click **Next**.

## Operating System Compatibility

Click **Next**.

## Domain Controller Type

Accept the default, "Domain controller for new domain" radio button by clicking **Next**.

## Create New Domain

Accept the default, "Domain in a new forest" radio button by clicking **Next**.

## Install or Configure DNS

Select **No** then click **Next**.

## New Domain Name

Enter the full DNS name in the text box. For example: Velocity.com

Click **Next**. Setup search for the domain name. This may take 1–2 minutes.

## NetBIOS Domain Name

In the Domain NetBIOS Name field, accept or enter the name **VELOCITY** then click **Next**. (In most cases, this domain name is automatically supplied by the installer.)

This name is used for older versions of windows to address this server. For the computer name, refer to page 23.

## Database and Log Locations

Accept the default locations (C:\WINDOWS\NTDS) and click **Next**.
### At this screen:  Do this:

<table>
<thead>
<tr>
<th>Shared System Volume</th>
<th>Accept the default location (C:\WINDOWS\SYSVOL) and click <strong>Next</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permissions</td>
<td>Accept the default &quot;Permissions compatible only with Windows Server 2003 operating systems&quot; radio button by clicking <strong>Next</strong>.</td>
</tr>
<tr>
<td>Directory Services</td>
<td>In the Password field, enter a secure password, then confirm this password at the Confirm field. This password can either be the same as the Administrator password or a different one, as required by your system administrator. Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Administrator Password</td>
<td>Remove the Windows CD from the CD drive. Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Completing the Active Directory Installation Wizard</td>
<td>Click <strong>Finish</strong>.</td>
</tr>
<tr>
<td>Restart prompt</td>
<td>Click <strong>Restart Now</strong>. Windows reboots. If you see a message to press a key, ignore it.</td>
</tr>
<tr>
<td>Welcome to Windows</td>
<td>Press <strong>Ctrl+Alt+Delete</strong>.</td>
</tr>
<tr>
<td>Log On to Windows</td>
<td>Log on using the default user name: <strong>Administrator</strong>. Specify the administrator password. Click <strong>OK</strong>. Windows Server 2003 desktop reappears.</td>
</tr>
</tbody>
</table>
Installing the Operating Systems

Velocity 3.1 R3 Installation Guide

Installing Windows Server 2003 Service Pack

After you have installed Windows Server 2003, you must download Windows Server 2003 Service Pack 2 from Microsoft Download Center and install it on this computer.

+ **This is a good time to install your video, audio, and bus drivers for this server and configure them. These drivers are usually contained on a Drivers and Utilities CD (like Dell) that comes with your system.**

Install Velocity as described in "Velocity Installation" on page 40.

+ **We recommend that you install all relevant Windows updates at this time. Simply go to the Microsoft website, download all applicable updates, then install them as required.**

Installing Windows XP, Windows Vista, or Windows 7

You can use the Windows XP, Windows Vista, or Windows 7 operating system for running Velocity in either client or standalone mode. Professional, Enterprise, and Ultimate Editions of the XP, Vista, and Windows 7 operating systems are supported.

+ **If you are installing Windows XP, do not try to substitute Windows XP Home Edition. The Home Edition doesn’t work with Windows domains and doesn’t contain the advanced management and security features you need in order to run Velocity.**
The quickest path to installing any of these Windows operation systems is to read the *Quick Start* and *Getting Started* guides that come with the Windows package as well as the release notes located in the root directory of the Windows DVD or CD.

Follow the instructions provided by Microsoft for installing them.

Once you have installed the appropriate operating system, you must specify the TCP/IP address for this computer that includes the subnet mask and default gateway of the LAN on which the Velocity server resides.

For information on which address and other values to specify, consult your IT supervisor.

Each of these Windows versions also requires the installation of a service pack:

- If you have installed Windows XP, you must download Windows XP Service Pack 3 from Microsoft Download Center and install it on this computer.
- If you have installed Windows Vista, download Service Pack 2 from the Microsoft Download Center and install it.
If you have installed Windows 7, download Service Pack 1 from the Microsoft Download Center and install it. After the reboot is completed, return to the Windows desktop.

This is a good time to install your video, audio, and bus drivers for this workstation or client and configure them. These drivers are usually contained on a Drivers and Utilities CD (like Dell) that comes with your system.

Install Velocity as described in “Velocity Installation” on page 40.
Turning Off Windows Firewall

Once you have installed the version of Windows you require, we recommend that you turn off Windows Firewall before continuing. This is done because there are times during the course of installing SQL Server or Velocity 3.1, when the firewall may conflict with various installation steps. To avoid condition, do this:

1. From Windows desktop, select **Start > Control Panel**.
   The Control Panel appears.
2. Select **Security Center**.
   The Security Center appears.
3. Turn off the Firewall.

You can turn the Firewall on after you have finished installing Velocity 3.1. For more on this, refer to “Turning On Windows Firewall” on page 85.
SQL Server Installation

You can use SQL Server 2008 R2 Express which is installed automatically with Velocity 3.1 R3. Before you take this step, refer to “Limitations of SQL Server 2008 R2 Express” on page 32 which describes the limitations inherent in SQL Server 2008 R2 Express.

If you are installing SQL Server 2008, see “Installing SQL Server 2008,” starting on page 33. For instructions on installing a full version of SQL Server 2005, refer to “Installing SQL Server 2005,” starting on page 36.

Limitations of SQL Server 2008 R2 Express

SQL Server 2008 R2 Express limitations do exist; however they are reasonable. The basic limitations are:

- 1 GB of RAM.
  SQL Server 2008 R2 Express utilizes a maximum of 1 GB of RAM, even if more RAM is available.
- 10 GB per database.
  Each database can be a maximum of 10 GB in size.
- 1 CPU (including multiple cores).
  SQL Server 2008 Express only utilizes one CPU even on a multi-processor machine.
- Basic reporting services.
Installing SQL Server 2008

If you require a full version of SQL Server 2008, the installation instructions are provided below. A run-time version, SQL Server 2008 R2 Express, is provided with the Velocity 3.1 R3 installation.

To install SQL Server 2008:

1. Insert the SQL Server 2008 Installation DVD into your DVD drive. If your computer is set to auto-start, the installation program should begin automatically. If it doesn’t, open Windows Explorer and navigate to the inserted DVD directory and select setup.exe from the root directory.

2. Follow this procedure:

<table>
<thead>
<tr>
<th>From:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Compatibility</td>
<td>Click Run Program.</td>
</tr>
<tr>
<td>SQL Server Installation Center</td>
<td>Click Installation from left pane. Click New SQL standalone... option from right pane.</td>
</tr>
<tr>
<td>Product Key</td>
<td>Enter product key and click Next.</td>
</tr>
<tr>
<td>License Terms</td>
<td>Check ‘I accept.’ and click Next.</td>
</tr>
<tr>
<td>Setup Support Files</td>
<td>Click Install. The Setup Support files are installed.</td>
</tr>
<tr>
<td>Setup Support Rules</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Select:</td>
</tr>
<tr>
<td></td>
<td>• Database Engine Services</td>
</tr>
<tr>
<td></td>
<td>• Client Tools Connectivity</td>
</tr>
<tr>
<td></td>
<td>• Client Tools Backward Compatibility</td>
</tr>
<tr>
<td></td>
<td>• SQL Server Books Online</td>
</tr>
<tr>
<td></td>
<td>• Management Tools – Basic</td>
</tr>
<tr>
<td></td>
<td>• Management Tools – Complete</td>
</tr>
<tr>
<td></td>
<td>Click Next.</td>
</tr>
<tr>
<td><strong>From:</strong></td>
<td><strong>Do this:</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>Instance Configuration</td>
<td>Enter the SQL Server network name. This is the name that will be available on the network for the clients. This varies depending on whether you select the default or a named instance. (By default, the instance name is <strong>Instance ID</strong>. Both the default instance name and instance ID are set as <strong>MSSQLSERVER</strong>. To use a non-default instance ID, select the 'Instance ID' box and specify a value.) Click <strong>Next</strong> continue with the installation.</td>
</tr>
<tr>
<td>Disk Space Requirement</td>
<td>Make sure you have enough space on your local disks to install the SQL Server 2008 then click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
You are returned to the Windows Server desktop.

3. Download and install the latest SQL Server 2008 service pack as required.

### From: Server Configuration

<table>
<thead>
<tr>
<th>Do this:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Click 'Use the Same Account For All Server Services'.</td>
<td></td>
</tr>
<tr>
<td>In the 'Use the Same Account For All Server Services' dialog box, click on the <strong>Browse</strong> button. The ‘Select User, Computer or Group’ window appears.</td>
<td></td>
</tr>
<tr>
<td>In the ‘Enter the object name to select’ text box, type the name of a Windows user. For example: <strong>Administrator</strong>.</td>
<td></td>
</tr>
<tr>
<td>Click the <strong>Check Names</strong> button. The user name is displayed in the ‘Enter the object name to select’ box. Click <strong>OK</strong> to return to the ‘Use the Same Account For All Server Services’ dialog box. The <strong>Domain Name\Administrator</strong> is displayed in the ‘Account Name’ drop-down box.</td>
<td></td>
</tr>
<tr>
<td>In the Password text box, enter the password and click <strong>OK</strong> to continue.</td>
<td></td>
</tr>
<tr>
<td>Select <strong>Automatic</strong> as the ‘Startup type’ to start the SQL Server Browser Service.</td>
<td></td>
</tr>
</tbody>
</table>

### From: Installation Configuration Rule

<table>
<thead>
<tr>
<th>Do this:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Next</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

### From: Ready to Install

<table>
<thead>
<tr>
<th>Do this:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Install</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

### From: Installation Progress

<table>
<thead>
<tr>
<th>Do this:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>The installer proceeds to install SQL Server. This will take more than 15 minutes. When it is finished, click <strong>Next</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

### From: Complete

<table>
<thead>
<tr>
<th>Do this:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Click <strong>Finish</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

If you need help, consult your IT department.
Installing SQL Server 2005

To install SQL Server 2005:

1. Insert the SQL Server 2005 Installation CD into your CD drive.
2. Follow this procedure:

<table>
<thead>
<tr>
<th>From:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>End User License</td>
<td>Check ‘I accept:’ and click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Installing Prerequisites</td>
<td>Click <strong>Install</strong>. The Prerequisites are installed.</td>
</tr>
<tr>
<td>Welcome</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>System Configuration Check</td>
<td>When the check is finished, click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Name and company fields are automatically supplied. Enter your 25-character product key then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Components to Install</td>
<td>Check first (SQL Server Database...) and last (Workstation...) boxes then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>User Information</td>
<td>Windows Server supplies the default Name and Organization. If required, you can enter new values. Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Instance Name</td>
<td>Click ‘Named Instance’ radio button, enter <strong>HIRSCH</strong> (uppercase) in text field, then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Service Account</td>
<td>At 'Use a domain user account', enter user name and password. If this is a domain account, also enter the domain name. To set up a user account for either local account or domain account, refer to “Setting Up SQL Server User Accounts” on page 37. Click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
You are returned to the Windows Server desktop.

3. Download and install the latest SQL Server 2005 service pack.

You are now ready to install Velocity 3.1 R3. For more on this, refer to "Velocity Installation" on page 40.

**Setting Up SQL Server User Accounts**

If you have not already set up a separate user name for this SQL Server account, use the instructions below.

*If this is a local user account*, do this:

1. At Windows desktop, select **Start > Control Panel > Administrative Tools > Computer Management**.
   
The Computer Management screen appears.
2. From the left pane, expand the **Local Users and Groups** folder.
3. Right click the **Users** subfolder.
4. From the pop-up list, select **New User**…
   
The New User dialog box appears.

### From: | Do this:
--- | ---
Authentication Mode | Accept the 'Windows Authentication Mode' radio button and click **Next**.
Collation Settings | Accept the default 'SQL collations' radio button and click **Next**.
Error and Usage Report Settings | Click **Next**.
Ready to Install | Click **Install**.
Installing Microsoft SQL Server | The installer proceeds to install SQL Server. This will take more than 15 minutes.
Setup Progress | When setup is finished, click **Next**.
Completing Microsoft SQL Server 2005 Setup | Click **Finish**.
5. Enter a user name and password. Also, uncheck the ‘User must change...’ box and check the ‘Password never expires’ box, like the following example:

   ![Password dialog box](image)

   If you need the password to expire, retain the default setting. Consult your system administrator for your own system requirements.

6. Click **Create**.
7. Click **Close**.

    *If this is a domain user account, do this:*

   1. At Windows desktop, select **Start > Control Panel > Administrative Tools > Active Directory Users and Computers**.
      
      The Active Directory Users and Computer screen appears.
    2. From the left pane, right click the **Users** folder.
      
      From the pop-up list, select **New > User**.
    4. Enter first name, last name, user logon name, then click **Next**.
    5. Enter the password and confirm it. Also, uncheck ‘User must change password at next logon’ box and check the ‘Password never expires’ box, like the example below:

   ![User dialog box](image)

   If you need the password to expire, retain the default setting. Consult your system administrator for your own system requirements.
6. Click **Next**.
   The third page appears.

7. Click **Finish**.

The user name and password information you have specified should be entered on the Service Account page. If this is a domain user, also enter the name of the domain. If you don’t know the domain name, consult your system administrator.
Velocity Installation

Follow the instructions below and within minutes you should be ready to use a new Velocity 3.1 R3.

+ If you have Velocity 2.5 installed on your system and want to upgrade to Velocity 3.1 R3, you must first upgrade from v2.5 to v2.6 then upgrade to v2.6 sp2, before upgrading from v2.6 sp2 to Velocity 3.1 R3. Use the instructions in “Velocity Update Wizards,” starting on page 179 of the Velocity 3.1 Installation Guide.

If you already have Velocity 2.6 SP2 or Velocity 3.0 on your machine, along with either an active SQL Server 2005 or SQL 2005 Express database, skip the following subsections and go directly to “Upgrading Velocity 2.6 SP2 to Velocity 3.1 R3” on page 190 or “Upgrading Velocity 3.0 to Velocity 3.1 R3” on page 196.

Preliminary Recommendations

We recommend that before you proceed with installing Velocity, you connect all the hardware devices you will need including:

- Video capture card
- Enrollment station
- Modem
- CCTV
- Printers

Then load required printer drivers—particularly your badge and report printers. Set the default orientation for the badges you plan to print. While it isn’t necessary to do this before you actually install Velocity, it can save you time later in the configuration process.

For more on these topics, refer to the user and installation guides for each of these devices. Also, consult the chapters later in this manual for specific installation and configuration instructions on several devices.
Installing Velocity

You must install Velocity onto the Velocity server first, then, if you have Velocity clients attached to the Velocity server, install Velocity on those machines next.

To install Velocity:

1. Insert the Velocity DVD into your DVD drive.
   If your DVD drive is not set to perform autorun, perform the following steps:

<table>
<thead>
<tr>
<th>From:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows desktop</td>
<td>Select <strong>Start &gt; Run.</strong></td>
</tr>
<tr>
<td>Run dialog box</td>
<td>Click the <strong>Browse...</strong> button.</td>
</tr>
<tr>
<td>Browse dialog box</td>
<td>Go to the DVD drive (usually D: or higher) and select the root directory. Select the program <code>setup.exe</code>. Click <strong>Open</strong>.</td>
</tr>
<tr>
<td>Run dialog box</td>
<td>The Velocity setup program and path appear.</td>
</tr>
<tr>
<td>Velocity Installer</td>
<td>Skip to Step 2.</td>
</tr>
<tr>
<td>screen</td>
<td><strong>OK</strong></td>
</tr>
</tbody>
</table>

If your DVD is set to autorun, then skip to Step 2.
The first Velocity Installer screen appears:

To read the Release Notes, click the View Release Notes button. The Release Notes appear. This provides you with important up-to-the-minute details on this Velocity release.

2. Click Next.

The installation procedure that follows depends on which operating system and database manager you are using.

- If you are using SQL Server 2008 on Windows Server 2008 R2, go to “Installing Velocity on Windows Server 2008 R2 with SQL Server 2008” on page 43.
- If you are planning to run Velocity on Windows XP SP3, Vista with SP1, or Windows 7, with SQL 2005 or SQL 2008, go to “Installing Velocity on Windows XP SP3, Vista, or Windows 7” on page 71.
Installing Velocity on Windows Server 2008 R2 with SQL Server 2008

To install Velocity using Windows Server 2008 R2 with either SQL Server 2008 or SQL Server 2008 R2:

1. If SQL Server 2005 Backward Compatibility Setup Wizard has been run previously, go to Step 2.

   If the SQL Server 2005 Backward Compatibility Setup Wizard has not been previously run, it now appears. Follow these steps:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server...</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>to begin</td>
<td></td>
</tr>
<tr>
<td>Welcome to...</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click the <strong>I accept the terms of</strong></td>
</tr>
<tr>
<td></td>
<td>** the license agreement** radio</td>
</tr>
<tr>
<td></td>
<td>button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Enter your name and the name of</td>
</tr>
<tr>
<td>Information</td>
<td>your organization in the appropriate</td>
</tr>
<tr>
<td></td>
<td>text fields.</td>
</tr>
<tr>
<td></td>
<td>When you're finished, click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>If required, select the program</td>
</tr>
<tr>
<td></td>
<td>features you require. In most cases,</td>
</tr>
<tr>
<td></td>
<td>you will simply accept the default by</td>
</tr>
<tr>
<td></td>
<td>clicking <strong>Next</strong>.</td>
</tr>
<tr>
<td>Ready to Install the</td>
<td>Click <strong>Install</strong>. The backward</td>
</tr>
<tr>
<td>Program</td>
<td>compatibility program is installed.</td>
</tr>
<tr>
<td>Completing...</td>
<td>Click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>

The Microsoft SQL Server Native Client Setup Wizard now appears.
2. Follow these steps for installing the Microsoft SQL Server Native Client:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Click <em>Next</em>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click to select the <strong>I accept the terms of the license agreement</strong> radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Enter your name and organization in the appropriate text boxes then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Select the program features you want for this installation. In most cases, you will accept the default then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Ready to Install</td>
<td>Click <strong>Install</strong> to start the installation.</td>
</tr>
<tr>
<td>Completing...</td>
<td>When the installation is completed, click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>

The SQL Server 2008 Native Client setup wizard now appears.

3. Follow these steps for installing the SQL Server 2008 Native Client:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Click <em>Next</em>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click to select the <strong>I accept the terms of the license agreement</strong> radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Enter your name and organization in the appropriate text boxes then click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
4. Click **Next**.

The Velocity End-User License Agreement (EULA) dialog box appears:

If you want to study the terms of the agreement more closely, you can click the **Print** button and make a hard copy of the agreement.

5. Click the **I agree...** radio button, then click **Next**.

The installer inspects your computer and determines which Velocity version your computer is capable of running.
The Install Options screen appears like this example:

If your Velocity computer is not a member of a domain, only the **Workstation** option is selectable.

If the installer detects that this machine is a member of a domain, it provides a broader range of options.

6. Select the computer role you need:

<table>
<thead>
<tr>
<th>Computer Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server</strong></td>
<td>This machine will serve as the Velocity server and client. It will manage Velocity services for connections with other clients as well as communications to controllers.</td>
</tr>
<tr>
<td><strong>Client</strong></td>
<td>This machine will serve as a client to the Velocity server. It will be able to access the database associated with the Velocity server.</td>
</tr>
<tr>
<td><strong>Data</strong></td>
<td>This machine will serve as the database server for this Velocity system.</td>
</tr>
<tr>
<td><strong>Workstation</strong></td>
<td>This machine will serve as both the server and client in a standalone security environment. No other client connections are supported.</td>
</tr>
</tbody>
</table>
7. Depending on which option you selected in Step 6, follow these instructions:

<table>
<thead>
<tr>
<th>If you select:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server</strong></td>
<td>At the ‘SQL Server location’ text box, either enter the path and directory of the SQL Server or click the browse button to locate the SQL Server folder. Click <strong>Next</strong>. The Application Security page appears. Go to step 8 on page 49.</td>
</tr>
</tbody>
</table>

<p>| <strong>Client</strong>     | In the ‘Velocity Server location’ either select the currently displayed Velocity server, pick another one from the drop-down list (if present), or click the browse button and the Network Neighborhood dialog box appears. Select the computer, drive, and directory where the Velocity server resides. In the ‘SQL Server location’ field, either accept the currently displayed SQL server, pick another from the drop-down list, or click the browse button and select the computer, drive, and directory you require at the Network Neighborhood dialog box. Click <strong>Next</strong>. The System Inspection screen appears. Go to step 12 on page 50. |</p>
<table>
<thead>
<tr>
<th>If you select:</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| **Data**      | Click **Next**. The Attach Database Wizard welcome screen appears.  
                Click **Next**. The EULA screen appears.  
                Check the **I Agree...** box then click **Next**. The System Inspection screen appears.  
                Click **Next**. The SQL Server Options appear:  
                Select the SQL Server instance you require then click **Next**.  
                The Application Security screen appears. Go to step 8 on page 49. |
| **Workstation** | Click **Next**. The Application Security page appears.  
                  Go to step 8 on page 49. |
The Application Security page appears like this example:

Velocity installer detects whether this computer is a member of a domain server (Active Directory) or is a local server. The correct radio button should be selected automatically.

If this is a split server configuration (meaning the Velocity application and database servers are run on the same domain but on different computers), the Application Security page looks like this:

8. If the 'Active Directory' radio button is selected, select the domain or organizational unit (OU) whose accounts Velocity can use.
Only those domains and OUs currently defined for this network appear in this list.

9. Enter a password at the first 'Password' text box and confirm it. This is the password used for Velocity services.

10. Unless you require a different SQL application role password, accept the [Default] password at the second 'Password' and 'Confirm' text boxes.

    If you change this password, you will need to enter this new password for all new clients in order for the clients to connect.

11. Click **Next**.
    • If this is the Data installation, the Prerequisite Gathering Complete screen appears. Go to step 16 on page 52.
    • If this is the Server, Client, or Workstation installation, the System Inspection screen appears.

12. Click **Next**.
    • If this is a Client installation, the Application Installation screen appears. Go to step 15 on page 51.
    • If this is the Server, Data, or Workstation installation, the SQL Server screen appears like this example:

    ![SQL Server Installation Screen]

13. Click **Next** to confirm “Install a HIRSCH named instance of SQL Express on this computer”.
    This will install SQL Server 2008 R2 Express on your computer.
    If you click the “Create a named instance using the existing SQL server” option then **Next**, the installer uses the currently installed version of SQL Server to use with Velocity.
The Database Installation screen appears like this example:

14. Click **Next** to accept the default location.

   The Application Installation dialog box appears.

15. Click **Next** to accept the default location.

   If you need to change the location of the Velocity program, enter a new path in the Folder window or click the **Browse...** button to select a new Velocity folder.
The Prerequisite Gathering Complete screen appears.

16. Review the settings in the window to make sure the tasks are correct.
17. Click **Next**.
   A message like this appears:

   ![Velocity Installer Screen]

   Tutorials are very helpful in learning how to perform Velocity tasks.
18. Do one of these:
   - Click **No** to bypass this step. The tutorials will not be available for either Velocity Help or the Velocity Learning Center to use. (You can always copy and paste the tutorials later, if you need them.)
   - Click **Yes** to install the tutorials so that they are available for use from either Velocity Help or the Velocity Learning Center. It will take several additional minutes to install the tutorials.
If you earlier specified that this computer will be used as a Velocity client, a prompt like this appears:

19. Click **Yes** to skip the installation of SQL Server 2008 R2 Express on this machine.
   
   If you want to install SQL Server 2008 R2 Express on this machine, click **No**.
   
   Velocity prerequisites and program are installed. This can take a while to run.
   
   When the installation is completed, the Installation Complete screen appears like this example:

![Installation Complete Screen](image)

20. Check boxes as you need on this screen:

   **Auto-start each time**  
   Check this radio button if you want Velocity to automatically start each time you log onto Windows. This is a good idea if you plan to use this computer only for Velocity. If this is a multi-use computer, you might leave this option unchecked.
Once you’ve made your selections, click Close.
After you close the installer, a message like this may appear:

![Velocity Update](image)

21. Click OK.
22. The Update for Velocity 3.1 screen appears.
23. Click Start.
The installer will now apply the updates for Velocity 3.1 R3.
Installing Velocity on Windows 2003 Server with SQL 2005

To install Velocity on Windows 2003 Server with SQL 2005, follow these instructions:

1. If SQL Server 2005 Backward Compatibility Setup Wizard has been run previously, go to Step 2.
   
   If the SQL Server 2005 Backward Compatibility Setup Wizard has not been previously run, it now appears. Follow these steps:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server... to begin</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Welcome to...</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click the <strong>I accept the terms of the license agreement</strong> radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Enter your name and the name of your organization in the appropriate text fields. When you're finished, click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Select the program features you require. In most cases, you will accept the default by clicking <strong>Next</strong>.</td>
</tr>
<tr>
<td>Ready to Install the Program</td>
<td>Click <strong>Install</strong>. The program is installed.</td>
</tr>
<tr>
<td>Completing...</td>
<td>Click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>

If the Microsoft SQL Server 2008 Native Client has been previously run, skip to Step 3.
2. Follow these steps for installing the Microsoft SQL Server Native Client:

<table>
<thead>
<tr>
<th>At this screen</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click to select the <strong>I accept the terms of the license agreement</strong> radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Enter your name and organization in the appropriate text boxes then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Select the program features you want for this installation. In most cases, you will accept the default then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Ready to Install</td>
<td>Click <strong>Install</strong> to start the installation.</td>
</tr>
<tr>
<td>Completing...</td>
<td>When the installation is completed, click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>

The SQL Server 2008 Native Client setup wizard now appears.

3. Follow these steps for installing the SQL Server 2008 Native Client:

<table>
<thead>
<tr>
<th>At this screen</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click to select the <strong>I accept the terms of the license agreement</strong> radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Enter your name and organization in the appropriate text boxes then click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>
If the installer detects that you need to install .NET Frameworks 3.5 SP1, a screen like this appears:

If you have previously installed .NET Frameworks, skip Step 4 and go to Step 5.

4. To install .NET Frameworks 3.5 SP1, follow these steps:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome to Setup</td>
<td>Click the <strong>I have read and ACCEPT the terms of the License Agreement</strong> radio button, then click Install.</td>
</tr>
<tr>
<td>Download and Install Program</td>
<td>The program is installed.</td>
</tr>
<tr>
<td>Setup Complete</td>
<td>Click <strong>Exit</strong>.</td>
</tr>
<tr>
<td>Restart</td>
<td>Click <strong>Restart Now</strong>.</td>
</tr>
<tr>
<td></td>
<td>The computer where you are installing Velocity is restarted.</td>
</tr>
</tbody>
</table>

The computer reboots.
5. Restart Setup.exe from the DVD as described in Step 1 on page page 41.
The Velocity Welcome screen appears.

6. Click **Next**.
   A message appears indicating that the Windows installer 4.5 will reboot when finished.

7. Click **OK**.
   The installer prompts you to provide the required hotfix for Windows Server 2003. Go to Step 7.

   *If a hotfix has already been provided for Windows 2003, skip Step 7 and go to Step 9.*

8. To install Windows Server 2003 hotfix, perform these steps:

<table>
<thead>
<tr>
<th>Hotfix for Windows 2003</th>
<th>Click <strong>Next</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>KB3184288-v4</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>License Agreement</th>
<th>Click the &quot;I Agree&quot; radio button then click <strong>Next</strong>.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Completing the Hotfix...</th>
<th>Click <strong>Finish</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The computer reboots.</td>
</tr>
</tbody>
</table>

9. Restart Setup.exe from the DVD as described in Step 1 on page page 41.
The Velocity Welcome screen appears.

10. Click **Next**.
    A message appears informing you that the Microsoft Windows PowerShell 1.0 is about to begin.

11. Click **OK**.
12. To install Windows PowerShell, perform these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Update Installation Wizard</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click the “I Agree” radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Completing the Windows PowerShell...</td>
<td>Click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>

The installer inspects your computer and determines which Velocity version your computer is capable of running.

13. Restart `Setup.exe` from the DVD as described in Step 1 on page 41.

   The Velocity Welcome screen appears.

14. Click **Next**.

   The Velocity End-User License Agreement (EULA) dialog box appears:

   ![License Agreement Dialog Box](image)

   If you want to study the terms of the agreement more closely, you can click the **Print** button and make a hard copy of the agreement.

15. Click the **I agree...** radio button, then click **Next**.

   The installer inspects your computer and determines which Velocity version your computer is capable of running.
The Install Options screen appears like this example:

![Install Options Screen](image)

If your Velocity computer is not a member of a domain, only the **Workstation** option is selectable.

If the installer detects that this machine is a member of a domain, it provides a broader range of options.

16. Select the computer role you need:

<table>
<thead>
<tr>
<th>Computer Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server</strong></td>
<td>This machine will serve as the Velocity server and client. It will manage Velocity services for connections with other clients as well as communications to controllers.</td>
</tr>
<tr>
<td><strong>Client</strong></td>
<td>This machine will serve as a client to the Velocity server. It will be able to access the database associated with the Velocity server.</td>
</tr>
<tr>
<td><strong>Data</strong></td>
<td>This machine will serve as the database server for this Velocity system.</td>
</tr>
<tr>
<td><strong>Workstation</strong></td>
<td>This machine will serve as both the server and client in a standalone security environment. No other client connections are supported.</td>
</tr>
</tbody>
</table>
17. Depending on which option you selected in Step 11, follow these instructions:

<table>
<thead>
<tr>
<th>If you select:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server</strong></td>
<td>At the ‘SQL Server location’ text box, either enter the path and directory of the SQL Server or click the browse button to locate the SQL Server folder. Click <strong>Next</strong>. The Application Security page appears. Go to step 18 on page 63.</td>
</tr>
<tr>
<td><strong>Client</strong></td>
<td>In the ‘Velocity Server location’ either select the currently displayed Velocity server, pick another one from the drop-down list (if present), or click the browse button and the Network Neighborhood dialog box appears. Select the computer, drive, and directory where the Velocity server resides. In the ‘SQL Server location’ field, either accept the currently displayed SQL server, pick another from the drop-down list, or click the browse button and select the computer, drive, and directory you require at the Network Neighborhood dialog box. Click <strong>Next</strong>. The System Inspection screen appears. Go to step 22 on page 64.</td>
</tr>
</tbody>
</table>

If you already have SQL Server 2005 installed on your PC, Velocity detects and uses SQL Server instead of SQL Server 2005 Express for the Velocity database.
If you select: | Do this:
--- | ---
**Data** | Click **Next**. The Attach Database Wizard welcome screen appears. Click **Next**. The EULA screen appears. Check the **I Agree...** box then click **Next**. The System Inspection screen appears. Click **Next**. The SQL Server Options appear:

![SQL Server Options](image)

Select the SQL Server instance you require then click **Next**. The Application Security screen appears. Go to step 18 on page 63.

**Workstation** | If a full version of SQL Server 2005 is installed on this computer, select it from the ‘SQL Server instances’ pick list; otherwise, accept the default Express version. Click **Next**. The Application Security page appears. Go to step 18 on page 63.
The Application Security page appears like this example:

Velocity installer detects whether this computer is a member of a domain server (Active Directory) or is a local server. The correct radio button should be selected automatically.

If this is a split server configuration (meaning the Velocity application and database servers are run on the same domain but on different computers), the Application Security page looks like this:

18. If the 'Active Directory' radio button is selected, select the domain or organizational unit (OU) whose accounts Velocity can use.
Only those domains and OUs currently defined for this network appear in this list.

19. Enter a password at the first 'Password' text box and confirm it. This is the password used for Velocity services.

20. Unless you require a different SQL application role password, accept the [Default] password at the second 'Password' and 'Confirm' text boxes.

   If you change this password, you will need to enter this new password for all new clients in order for the clients to connect.

21. Click **Next**.
   - If this is the Data installation, the Prerequisite Gathering Complete screen appears. Go to step 23 on page 65.
   - If this is the Server, Client, or Workstation installation, the System Inspection screen appears.

22. Click **Next**.
   - If this is a Client installation, the Application Installation screen appears. Go to step 25 on page 68.
   - If this is the Server, Data, or Workstation installation, the SQL Server screen appears like this example:
23. Select one of the following options then click **Next**:

**Install a HIRSCH named instance of SQL Express on this computer**

Click this radio button to instruct Velocity installer to install the run-time version of SQL Server, SQL Server 2008 R2 Express.

If you select this option then click **Next**, Velocity installer creates a new instance of SQL 2008 R2 Express on this computer and the Database Installation screen appears. Go to step 24 on page 67.

**Create a named instance using the existing SQL server**

Click this radio button to instruct Velocity installer to use the existing version of SQL Server and modify it for use by Velocity.

This option is only active when Velocity installer detects a full version of SQL Server that does not already contain a Velocity database.

If you select this option then click **Next**, Velocity installer creates a new named instance called HIRSCH and attaches the database automatically. The next screen you see is the Application Installation screen. Go to step 25 on page 68.
Velocity 3.1 R3 Installation Guide

| Use the existing HIRSCH named instance of SQL Server 2005 | Click this radio button to instruct Velocity installer to use the existing version of SQL Server 2005 that already contains an existing Velocity database and associated schema. This option is only active or visible when Velocity installer detects a full version of SQL Server 2005 that contains an existing Velocity database. Normally, you would only see or select this option if you are reinstalling Velocity 3.1 or have an existing version of SQL 2005 Server that has been updated from an earlier version of SQL Server that contained Velocity data. If you select this option then click **Next**, the Application Installation screen appears. Go to step 25 on page 68. |

+ Velocity will install a named instance of SQL Express if no existing SQL Server exists. If a default instance of SQL Server Express already exists, it will create a named instance for it called HIRSCH, leaving the default instance as it is.

If a Hirsch named instance already exists on this computer, the installer will reuse it, backing up and removing any existing Velocity database that may already exist.
If you do not yet have SQL Server installed on your machine, the Database Installation screen appears like this example:

In general, it should not be necessary to change the default folder or volume designations for either the database or application files. Unless required, leave these at their default values.

If you have already installed a version of SQL Server, skip the next step and go to step 25 on page 68.

24. Click **Next** to accept the default location.

If, for some reason, you need to change the location where the installer places SQL 2008 R2 Express, click the **Browse...** button and select a replacement.

The Application Installation dialog box appears.
25. Click **Next** to accept the default location.

   If you need to change the location of the Velocity program, enter a new path in the Folder window or click the **Browse...** button to select a new Velocity folder.

   The Prerequisite Gathering Complete screen appears.

26. Review the settings in the window to make sure the tasks are correct.

27. Click **Next**.

   A message like this appears:

   ![Velocity Installer screen](image)

   Tutorials are very helpful in learning how to perform Velocity tasks.

28. Do one of these:

   - Click **No** to bypass this step. The tutorials will not be available for either Velocity Help or the Velocity Learning Center to use. (You can always copy and paste the tutorials later, if you need them.)
• Click Yes to install the tutorials so that they are available for use from either Velocity Help or the Velocity Learning Center. It will take several additional minutes to install the tutorials. If you earlier specified that this computer will be used as a Velocity client, a prompt like this appears:

29. Click Yes to skip the installation of SQL Server 2008 R2 Express on this machine. If you want to install SQL Server 2008 R2 Express on this machine, click No. Velocity prerequisites and program are installed. This can take a while to run. When the installation is completed, the Installation Complete screen appears like this example:
30. Check boxes as you need on this screen:

**Auto-start each time**
Check this radio button if you want Velocity to automatically start each time you log onto Windows. This is a good idea if you plan to use this computer only for Velocity. If this is a multi-use computer, you might leave this option unchecked.

**Place Velocity icon**
Check this radio button to place a Velocity icon on your desktop. This enables an operator to quickly start Velocity without going through the Start menu.

**Never re-use PIN codes**
Check this radio button if you never want to reuse PIN codes. If you have a large number of employees, you might need to recycle PIN codes or risk running out.

If you select this option, you can further specify that only those operators with override authority can reassign PIN codes.

**Never re-use MATCH card code**
Check this radio button if you never want to reuse MATCH card codes. While this option eliminates the possibility of an unauthorized person stealing and using a card, it requires new cards for each new person, which can be expensive.

If you select this option, you can further specify that only those operators with override authority can reassign cards.

31. Once you’ve made your selections, click **Close**.
After you close the installer, a message like this may appear:
32. Click **OK**.
   The Update for Velocity 3.1 screen appears.

33. Click **Start**.
   The installer will now apply the updates for Velocity 3.1 R3.

### Installing Velocity on Windows XP SP3, Vista, or Windows 7

To install Velocity on Windows XP SP3, Vista SP2, or Windows 7 using SQL Server 2008 R2 Express, SQL Server 2008, or SQL Server 2005, perform the following steps:

1. If SQL Server 2005 Backward Compatibility Setup Wizard has been run previously, go to Step 2.
   If the SQL Server 2005 Backward Compatibility Setup Wizard has not been previously run, it now appears. Follow these steps:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft SQL Server... to begin</strong></td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td><strong>Welcome to...</strong></td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td><strong>License Agreement</strong></td>
<td>Click the <strong>I accept the terms of the license agreement</strong> radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td><strong>Registration Information</strong></td>
<td>Enter your name and the name of your organization in the appropriate text fields. When you’re finished, click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>

If you are running on Vista, you may encounter prompts to reboot after each prerequisite. To save time and irritation, click Reboot Later.
If you have previously installed .NET Frameworks or you are using either Vista or Windows 7, skip Step 2 and go to Step 3.

2. If the Microsoft SQL Server Native Client Setup Wizard has not been previously run, it now appears. Follow these steps:

<table>
<thead>
<tr>
<th>At this screen</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature Selection</td>
<td>Select the program features you require. In most cases, you will accept the default by clicking Next.</td>
</tr>
<tr>
<td>Ready to Install the Program</td>
<td>Click Install. The program is installed.</td>
</tr>
<tr>
<td>Completing...</td>
<td>Click Finish.</td>
</tr>
</tbody>
</table>

If you have previously installed .NET Frameworks or you are using either Vista or Windows 7, skip Step 2 and go to Step 3.

If the Microsoft SQL Server 2008 Native Client Setup Wizard has been previously run, go to Step 5.
3. If the Microsoft SQL Server 2008 Native Client Setup Wizard has not been previously run, it now appears. Follow these steps:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click to select the <strong>I accept the terms of the license agreement</strong> radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Enter your name and organization in the appropriate text boxes then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Select the program features you want for this installation. In most cases, you will accept the default then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Ready to Install</td>
<td>Click <strong>Install</strong> to start the installation.</td>
</tr>
<tr>
<td>Completing...</td>
<td>When the installation is completed, click <strong>Finish</strong>.</td>
</tr>
</tbody>
</table>

If the installer detects that you need to install .NET Frameworks 3.5 SP1, a screen like this appears:

If you are running Windows Vista or Windows 7, or have previously installed a version of .NET Frameworks, skip Step 4 and go to Step 5.

Velocity XP normally requires the installation of this .NET Frameworks 3.5 SP1 software.
4. To install Microsoft .NET Framework 3.5 SP1, follow these steps.

<table>
<thead>
<tr>
<th>At this screen</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity .NET... about to begin</td>
<td>Click <strong>OK</strong>. The .NET installer extracts the required files.</td>
</tr>
<tr>
<td>Welcome to Setup</td>
<td>Click the <strong>I have read and ACCEPT the terms of the License Agreement</strong> radio button, then click <strong>Install &gt;</strong>.</td>
</tr>
<tr>
<td>Download and Install Program</td>
<td>The program is installed.</td>
</tr>
<tr>
<td>Setup Complete</td>
<td>Click <strong>Exit</strong>.</td>
</tr>
<tr>
<td>Restart</td>
<td>Click <strong>Restart Now</strong>. The computer where you are installing Velocity is restarted.</td>
</tr>
</tbody>
</table>

A message appears indicating that the Windows installer 4.5 installation will begin.
If Velocity is being installed on Windows Vista or Windows 7, skip Steps 5 through 7 and go to Step 8.

5. Click **OK**.
The Hotfix for Windows XP appears.

6. To install Windows XP hotfix, perform these steps:

<table>
<thead>
<tr>
<th>Window</th>
<th>At this screen</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hotfix for Windows XP</td>
<td>Click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click the “I Agree” radio button then click <strong>Next</strong>.</td>
<td></td>
</tr>
<tr>
<td>KB942288-v3 Setup</td>
<td>Click <strong>Continue</strong>.</td>
<td></td>
</tr>
<tr>
<td>Completing the Hotfix...</td>
<td>Click <strong>Finish</strong>. The computer reboots.</td>
<td></td>
</tr>
</tbody>
</table>
The computer reboots.
7. Restart Setup.exe from the DVD as described in Step 1 on page 41.
   The Velocity Welcome screen appears.
8. Click Next.
   A message appears informing you that the Microsoft Windows PowerShell 1.0 is about to begin.
9. Click OK.
10. To install Windows PowerShell, perform these steps:
   
   Software Update Installation Wizard
   License Agreement
   Completing the Windows PowerShell...

   Click Next.
   Click the “I Agree” radio button then click Next.
   Click Finish.

11. Restart Setup.exe from the DVD as described in Step 1 on page 41.
   The Velocity End-User License Agreement (EULA) dialog box appears:

   ![Velocity End-User License Agreement (EULA) dialog box]

   If you get a message informing you that the installation cannot continue because some files are outdated, click Yes to update and reboot.
   Once these files are updated, the installation should resume at the point where it left off.
If you want to study the terms of the agreement more closely, you can click the **Print** button and make a hard copy of the agreement.

12. Click the **I agree...** radio button, then click **Next**.
   The installer inspects your computer and determines which Velocity version your computer is capable of running.
   The Install Options screen appears like this example:

   ![Install Options Screen]

   If your Velocity computer is not a member of a domain, only the **Workstation** option is selectable.
   If the installer detects that this machine is a member of a domain, it provides a broader range of options.

13. Select the computer role you need:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server</strong></td>
<td>This machine will serve as the Velocity server and client. It will manage Velocity services for connections with other clients as well as communications to controllers.</td>
</tr>
<tr>
<td><strong>Client</strong></td>
<td>This machine will serve as a client to the Velocity server. It will be able to access the database associated with the Velocity server.</td>
</tr>
</tbody>
</table>
14. Depending on which option you selected in Step 10, follow these instructions:

**If you select:** | **Do this:**
--- | ---
**Server** | At the ‘SQL Server location’ text box, either enter the path and directory of the SQL Server or click the browse button to locate the SQL Server folder. Click Next. The Application Security page appears. Go to step 15 on page 79.

**Client** | In the ‘Velocity Server location’ either select the currently displayed Velocity server, pick another one from the drop-down list (if present), or click the browse button and the Network Neighborhood dialog box appears. Select the computer, drive, and directory where the Velocity server resides. In the 'SQL Server location' field, either accept the currently displayed SQL server, pick another from the drop-down list, or click the browse button and select the computer, drive, and directory you require at the Network Neighborhood dialog box. Click Next. The System Inspection screen appears. Go to step 19 on page 80.

---

**Data** | This machine will serve as the database server for this Velocity system.

**Workstation** | This machine will serve as both the server and client in a standalone security environment. No other client connections are supported.

---

If you already have SQL Server 2005 or SQL Server 2008 R2 installed on your PC, Velocity detects and uses that SQL Server instead of SQL Server 2005 Express for the Velocity database.
If you select:  Do this:

Data
Click Next. The Attach Database Wizard welcome screen appears.
Click Next. The EULA screen appears.
Check the I Agree... box then click Next. The System Inspection screen appears.
Click Next. The SQL Server Options appear:

Select the SQL Server instance you require then click Next.
The Application Security screen appears. Go to step 15 on page 79.

Workstation
If a full version of SQL Server 2005 is installed on this computer, select it from the ‘SQL Server instances’ pick list; otherwise, accept the default Express version.
Click Next. The Application Security page appears.
Go to step 15 on page 79.
The Application Security page appears like this example:

Velocity installer detects whether this computer is a member of a domain server (Active Directory) or is a local server. The correct radio button should be selected automatically.

If this is a split server configuration (meaning the Velocity application and database servers are run on the same domain but on different computers), the Application Security page looks like this:

15. If the 'Active Directory' radio button is selected, select the domain or organizational unit (OU) whose accounts Velocity can use.
Only those domains and OUs currently defined for this network appear in this list.

16. Enter a password at the first 'Password' text box and confirm it. This is the password used for Velocity services.

17. Unless you require a different SQL application role password, accept the [Default] password at the second 'Password' and 'Confirm' text boxes.

If you change this password, you will need to enter this new password for all new clients in order for the clients to connect.

18. Click **Next**.
   - If this is the Data installation, the Prerequisite Gathering Complete screen appears. Go to step 23 on page 82.
   - If this is the Server, Client, or Workstation installation, the System Inspection screen appears.

19. Click **Next**.
   - If this is a Client installation, the Application Installation screen appears. Go to step 22 on page 81.
   - If this is the Server, Data, or Workstation installation, the SQL Server screen appears like this example:

20. Click **Next**.
    The “Create a named instance using the existing SQL server” option is confirmed.
If you do not yet have SQL Server 2008 R2 installed on this machine, the Database Installation screen appears like this example:

In general, it should not be necessary to change the default folder or volume designations for either the database or application files. Unless required, leave these at their default values.

If you have already installed SQL Server 2008, skip the next step and go to step 21 on page 54.

21. Click **Next** to accept the default location.
   The Application Installation dialog box appears.

22. Click **Next** to accept the default location.
If you need to change the location of the Velocity program, enter a new path in the Folder window or click the **Browse...** button to select a new Velocity folder.

The Prerequisite Gathering Complete screen appears.

23. Review the settings in the window to make sure the tasks are correct.

24. Click **Next**.

A message like this appears:

```
Would you like to install the Tutorials folder? This will take several minutes. Please ensure you have enough free disk space.
```

Tutorials are very helpful in learning how to perform Velocity tasks.

25. Do one of these:
   - Click **No** to bypass this step. The tutorials will not be available for either Velocity Help or the Velocity Learning Center to use. (You can always copy and paste the tutorials later, if you need them.)
   - Click **Yes** to install the tutorials so that they are available for use from either Velocity Help or the Velocity Learning Center. It will take several additional minutes to install the tutorials.
If you earlier specified that this computer will be used as a Velocity client, a prompt like this appears:

26. Click **Yes** to skip the installation of SQL Server 2008 R2 Express on this machine.

If you want to install SQL Server 2008 R2 Express on this machine, click **No**.

Velocity prerequisites and program are installed. This can take a while to run.

When installation is completed, the Installation Complete screen appears like this example:

27. Check boxes as you need on this screen:

   **Auto-start each time**  Check this radio button if you want Velocity to automatically start each time you log onto Windows. This is a good idea if you plan to use this computer only for Velocity. If this is a multi-use computer, you might leave this option unchecked.
### Place Velocity icon
Check this radio button to place a Velocity icon on your desktop. This enables an operator to quickly start Velocity without going through the Start menu.

### Never re-use PIN codes
Check this radio button if you never want to reuse PIN codes. If you have a large number of employees, you might need to recycle PIN codes or risk running out.

If you select this option, you can further specify that only those operators with override authority can reassign PIN codes.

### Never re-use MATCH card code
Check this radio button if you never want to reuse MATCH card codes. While this option eliminates the possibility of an unauthorized person stealing and using a card, it requires new cards for each new person, which can be expensive.

If you select this option, you can further specify that only those operators with override authority can reassign cards.

28. Once you’ve made your selections, click **Close**.
   After you close the installer, a message like this may appear:

   ![Velocity Update Message]

29. Click **OK**.
   The Update for Velocity 3.1 screen appears.
30. Click **Start**.
   The installer will now apply the updates for Velocity 3.1 R3.
Turning On Windows Firewall

Once you have installed Velocity 3.1 R3, you can turn the Windows Firewall ON and configure the firewall to accommodate access to the required SQL Server and Velocity ports.

+ If you are unfamiliar with firewall port configuration, contact your IT department for more information on doing this.

In many circumstances, you will have to perform the following procedures:

- Configure Windows Firewall
- Assign a TCP/IP port to the SQL Server Database Engine
- Assign a TCP/IP port to the Velocity polling engine
- Start an instance of SQL Server

For more on these topics, refer to the following subsections.

Configuring Windows Firewall

Windows Firewall helps prevent unauthorized access to computers in the network. By default, Windows Firewall is turned ON once the operating system is installed. If a firewall is turned ON but it is not configured correctly, attempts made by users to connect to SQL Server and Velocity are blocked. In order to access an instance of SQL Server which is behind a firewall, the database administrator needs to configure the firewall on the computer that is running SQL Server in order to allow users access.

Opening ports in your firewall can leave your server exposed to malicious attacks. Make sure that you understand firewall systems before you open ports.

The following procedures will guide you through the steps that you need to configure Windows Firewall in Window Server 2008 R2 to allow SQL Server access to users.

1. Click Start > All Programs > Administrative Tools > Server Manager. The Server Manager appears.
2. In Server Manager, expand the **Configurations** tab then expand **Windows Firewall with Advanced Security**.
3. Right click **Inbound Rules** and click **New Rule**.
   The New Inbound Rule Wizard appears.
4. On the New Inbound Rule Wizard’s Rule Type page, select the **Port** option to control connections for a TCP or UDP Port. Click **Next** to continue with the wizard.
   The Protocol and Ports page appears.
5. On the Protocol and Ports page, specify the protocols and ports to which this rule applies.
   Since SQL Server, when installed as a default instance, uses port **1433** as the default port, choose the TCP option then specify a specific port number.
   Click **Next** to continue with the wizard.

   **Registered Ports** are those from **1024 through 49151** and **Dynamic and/or Private Ports** are those from **49152 through 65535**. The registered ports number ranges should not be used for named SQL Server instances as a future conflict is possible. Consult your IT department for assistance regarding port assignment.

6. On the Action page, specify the action to be taken when a connection matches the conditions specified in this rule. In this case, choose **Allow the connection** and click **Next**.
   The Profile page appears.
7. On the Profile page, select **Domain**. Click **Next**.
   The Name page appears.
8. On the Name page, provide a meaningful name and description. For example:
   **Name:**
   SQL Server 2008 default Port 1433
   **Description (Optional):**
   Enable SQL Server 2008 Default Port (1433) for user connectivity.
9. Click **Finish** to complete the wizard.
   Once the wizard configuration is complete, you will be able to see the new rule available under Inbound Rules.

10. Repeat Steps 3 through 7 to set the UDP Port to **1434**.

   + **Additionally, make sure TCP Port 2025 is open to enable connection from remote workstations (required for Velocity).**

### Assigning a TCP/IP Port Number to the SQL Server Database Engine

If enabled, the default instance of the SQL Server database engine listens on TCP port 1433. Named instances of the SQL Server database engine are configured for dynamic ports which means they select an available port when the SQL Server service is started.

When connecting to a named instance through a firewall, configure the database engine to listen on a specific port so that the appropriate port can be opened in the firewall.

To assign a TCP/IP port number to the SQL Server Database Engine

1. From the desktop, click **Start > All Programs > Microsoft SQL Server 2008 > Configuration Tools > SQL Server Configuration Manager**.
   The SQL Server Configuration Manager appears.

2. On the console pane, expand **SQL Server Network Configuration** then **Protocols for <instance name>** then double-click **TCP/IP**.
   The TCP/IP Properties dialog box appears.

3. Click to select the **IP Addresses** tab.

4. Scroll down and find the **IPAll**.

5. In the IPAll box, click the **TCP Port** text box and enter the port number on which you want this IP address to listen, then click **OK**.
   For example: select 2025 then click **OK**.

6. Restart the SQL instance as detailed in “Starting an Instance of SQL Server (SQL Server Configuration Manager)” on page 88.
Starting an Instance of SQL Server (SQL Server Configuration Manager)

To stop or start an instance of SQL Server from SQL Server Configuration Manager:

1. From the desktop, click **Start** > **All Programs** > **Microsoft SQL Server 2008** > **Configuration Tools** > **SQL Server Configuration Manager**.
   
   SQL Server Configuration Manager appears.

2. In the console pane, expand **SQL Server Services**.

3. In the details pane, right-click the named instance of SQL Server then click **Start**.
   
   For example: SQL Server (MSSQLSERVER)

   + **A green arrow on the icon next to the server name and on the toolbar indicates that the server started successfully.**

4. Click **OK** to close SQL Server Configuration Manager.
Starting Velocity

1. If you have not already logged into Windows, start Windows now. The Log On screen appears.

2. Log onto Windows initially as ‘Administrator’ or with the name of the person who installed Velocity.

3. Enter the administrator password you specified when setting up the administrator for Windows (see page 23). Hirsch’s suggested default for start-up is: HIRSCH123!

then click OK. The Windows desktop appears.

+ After the initial login, we strongly recommend that you change the Administrator’s default password from ‘HIRSCH123!’ to a more secure password. This is done from the Operators function within Velocity.

The Velocity Service Control Manager (SCM) icon appears in the desktop tray at the lower right corner of the screen. The appearance of the SCM icon determines which services are currently running:

<table>
<thead>
<tr>
<th>This icon:</th>
<th>Indicates:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>All services are started. A green arrow appears.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>DTNS is stopped. A red circle appears around a green arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Both DTNS and SDS are stopped. A red square dot appears in place of the green arrow.</td>
</tr>
</tbody>
</table>

Wait until the arrow turns green before proceeding. This can take 30 seconds or more after reboot or manual restart.

If SCM does not start automatically, from the Windows desktop select Start > All Programs > Hirsch Electronics Velocity > Service Control Manager. Services should start automatically on reboot.
4. Do one of these:
   - From the Windows desktop, select **Start > Programs > Hirsch Electronics Velocity > Velocity**.
   - If you have indicated during the installation that you wanted the Velocity shortcut icon to appear on the Windows desktop, you can double click this icon now.

The Velocity splash screen appears like this:

If this is the first time you have started Velocity 3.1 R3, a Product Registration screen appears. Register the product, using the Velocity Registration Wizard. You can ignore this screen and continue working in Velocity; however, after 30 days the registration screen will reappear each time you open Velocity.

**What’s Next**

The following two pages provide a flowchart of the most useful procedures for configuring and defining Velocity. (This flowchart is also found in the On-Line Help.)
What's Next
How Do I...

Once you’ve installed Velocity and its components, you can turn to Velocity Help for information on using any Velocity feature. This is an interactive program enabling you to either read about Velocity from beginning to end, or focus in on specific procedures.

You can use Velocity Help in any of these ways:

| On-Line Help      | Access Velocity Help using the Help Topics option located under the Help menu bar option (Help > Help Topics).
|                   | To help get you started, refer to the “Getting Started” section. |
| Context-Specific Help | Get help on a specific topic from one of the many help buttons or help options located throughout Velocity. Simply locate the screen or dialog box you need to know about and either click the associated Help button or select Help > Help Topics from the dialog box’s menu bar. |
| Tutorials | You can access the Velocity tutorials either through the Velocity Learning Center or Velocity On-Line Help. Before you can play tutorials, you must first copy the files from your Velocity DVD to your Velocity\Tutorials subdirectory. For more on this, refer to your On-Line Help or the readme file located on the Velocity DVD. |
When Velocity Online Help is launched from the main menu toolbar, it includes these panes and features:

- Contents pane
- Index pane
- Search pane
- Glossary pane
- Sequence pane
- Print Option (by selecting one or more topics)

Other Options

From your Acrobat Reader you can access these helpful items:

- DIGI*TRAC Design & Installation Guide
- Velocity 3.1 Quick Install Guide

Note: Acrobat Reader is installed by default on most computers. If you don’t have a copy of this free software, go to the Adobe website and download one.

From Notepad or another word processing program, you can access:

- Known Issues
- Registration
- Uninstall Information

94
The windows, buttons, and toolbar that comprise the Velocity Online Help screen look like the following example:

Once inside Velocity Help, use the Contents, Index or Search tabs to locate the specific topic you need. To display the relevant topic, just double click the entry.

There is also a Glossary tab that provides you with definitions for terms used in the help file.

You can also use the numerous links located throughout the document to jump from one topic to another as needed.

Notice that topics are arranged in sequences (the yellow window above the web page), so that you can read about related topics simply by clicking the topic in the sequence window or using the Previous or Next button to arrive at the topic you want.

To navigate to the last screen you displayed, click the Back button.

In addition, you can jump to related topics using the See Also topics list displayed at the bottom of most pages.

Use the Print Option for a hard copy of On-Line Help.
Installing Video Boards

Photos can be acquired in one of three ways:

- Digital camera
- TWAIN device
- Video capture board

Digital cameras normally produce JPG images which are easily imported to Velocity. TWAIN devices include TWAIN-compatible cameras and scanners which are attached to the Velocity badging station. The following section discusses the third option: how to install and configure video capture boards.

Cameras connected to video capture boards are used with Velocity to take photos of people. Video capture is the process by which employee pictures are shot (captured) using a special camera. These images are stored so that they may later be displayed for verification, used for photo call-up, or printed along with other information onto badges or dossier reports.

The capture board recommended by Hirsch is the Integral© FlashBus® Spectrim Lite video board.

*The FlashBus Spectrim Lite video board is available through Hirsch and replaces the FlashBus MV Lite. For more information, contact your Hirsch sales representative.*

Installing a FlashBus Spectrim Lite video capture board in the Velocity badging station involves these steps:

- Installing the Spectrim Lite drivers
- Installing the Spectrim Lite board

The procedure generally runs more seamlessly to install the software (drivers) before installing the hardware. In this way, when Windows detects the newly-installed board, you can immediately specify the location of the new driver on your hard disk.
Installing the Spectrim Lite Software

There are three ways to install Spectrim Lite drivers and programs:

- Use the Spectrim Lite CD that comes with the board.
- Download the latest FlashBus Spectrim Lite software from the Integral website (called ‘FlashBus Spectrim setup software’).

To install the required Spectrim Lite software:

1. Insert the Spectrim Lite CD into your CD drive.
   If you downloaded the latest software, use Windows Explorer to navigate to the directory where you copied it.
2. Using Windows Explorer, find the Spectrim Lite setup file, SETUP.EXE.
3. Double click SETUP.EXE.
4. Follow the wizard’s instructions and accept all the default settings as shown here:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Choose Destination Location</td>
<td>Accept default location. Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Select Components</td>
<td>Accept default selections. Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Select Program Folder</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Install finished</td>
<td>Click <strong>Finish</strong>. The computer restarts.</td>
</tr>
</tbody>
</table>
Installing the Spectrim Lite Board

Before a PC can receive or display camera video, the PC must have these capabilities:

- Velocity software
- One open PCI bus slot
- Windows XP
- High-resolution monitor

The board provides both composite (BNC) and SVideo connectors for connection to a camera.

To install the Spectrim Lite video board:

1. Power off computer, disconnect all peripherals, then unplug the PC.

   Ground yourself to remove static electricity before touching your board or any components inside the computer.

2. Remove the PC’s cover.

3. Select an empty PCI expansion slot.
   a. Remove the slot cover screw and cover.
   b. Grasp board by the top edge and carefully seat it firmly into the slot using a slight rocking motion.
   c. Fasten the retaining bracket to the chassis with the slot cover screw.

4. Reinstall the computer’s cover.
5. Connect the camera’s cable to one of the available video inputs—either the S-Video 4-pin mini DIN or the Composite Video BNC female connector as shown in the illustration below.

![S-Video Connector Diagram]

Every camera should come with an appropriate S-Video or BNC cable for one of these connectors.

*If you connect the camera to the BNC connector, you cannot connect to a CCTV system.*

6. Connect the camera power cord and adaptor to the nearest power outlet.
7. Restart the PC.
   Windows will detect the new video board and display the Found New Hardware dialog box.
8. Select ‘Search for a Suitable Driver for My Device’ and click **Next**.
9. Select ‘Specify a Location’ and click **Next**.
10. Browse to the drive and directory where you extracted and copied your new Spectrim driver during the previous extraction. This directory should be `C:\FB\Spectrim`.
11. Select the appropriate INF file, `FBS.INI`.
12. Click **OK**.
13. Click **Next** to install the driver.
   The Digital Signature Not Found dialog box appears.
14. Click **Yes**.
   The Finish dialog box appears.
15. Click **Finish** and **Yes** to restart the computer.

To verify that the FlashBus Spectrim driver is properly installed, complete the following steps:
1. In Control Panel, click **Sounds and Multimedia**.
2. Select the **Hardware** tab and look for FlashBus Spectrim Lite.

If the Spectrim Lite appears in the list, both the board and driver have been successfully loaded.

The Spectrim Lite can support a connection to both a CCTV system via the BNC port and a video capture camera via the SVide mini-DIN port. However, the two operations cannot be performed at the same time. When capturing photographs in Enrollment Manager, make sure that the CCTV Viewer is not operating and visa versa. If both the CCTV Viewer and the Enrollment Manager are required to operate at the same time, install two video input devices in your computer.
Signature Capture Devices

Velocity 3.1 has been tightly integrated with two signature capture devices.

In previous versions of Velocity you needed to use a TWAIN driver supplied by the signature capture device manufacturer or import signatures as JPEG images. This all changes with Velocity 3.1.

Velocity 3.1 now supports three models of signature capture devices:

- TT1500
- TT3100/TT3101
- TL462-HSB
Installing the Capture Device

All supported devices are described here.

To install the TT1500:

1. Make sure the power switch is turned off on the computer where you will be installing the TT1500.
2. Plug the 15-pin connector (HDB15) of the serial cable into the back of the TT1500 as shown in the following picture:

![Diagram showing installation steps]

3. Plug the 9-pin connector (DB9) of the serial cable into an available serial port on your computer (usually COM port 1).
   If your computer has a 25-pin serial port, you will need to obtain a 25-pin to 9-pin adapter from your local computer store or other source.
4. Plug the male connector of the AC power supply into the socket on the back of the 9-pin serial cable connector (DB9) which is plugged into the back of your computer.
5. Plug the base of the AC power supply into a standard 120 volt, 60 Hz, AC power outlet.

Installation is now complete. You may now turn on your computer. No software installation or additional driver installation is required.
To install the TT3100/3101:

1. Make sure the power switch is turned off on the computer where you will be installing the TT3100/3101.
2. Plug the 15-pin connector (HDB15) of the serial cable into the back of the TT3100/3101 as shown in the following illustration:

3. Plug the 9-pin connector (DB9) of the serial cable into an available serial port on your computer (usually COM port 1). You can only use COM 1 – 4 on the PC. This tablet does not work with a USB-to-serial converter, nor does it work with serial expansion cards if they are providing COM 5 or above.
4. Plug the male connector of the AC power supply cable into the socket on the back of the 9-pin serial cable connector (DB9) which is plugged into the back of your computer.
5. Plug the base of the AC power supply into a power outlet.

Installation is now complete. You may now turn on your computer. Your TT3100/3101 will auto-configure to RS-232. No software installation or additional driver installation is required.

To install the TL462-HSB:

1. Before connecting the TL462-HSB signature capture device, you must install the appropriate driver. To do this:
   a. Insert the CD that comes with the signature capture device into the CD drive of the appropriate computer.

The computer should autostart the CD and find the proper driver installation program.
b. Follow the instructions that appear on the screen to install the driver.
c. Once the installation is complete, remove the CD from the CD drive.

2. Plug the USB cable that comes with the device into the device.

3. Plug the other end of the cable into an available USB port on the computer.
   If you do not have an available USB port, purchase a USB hub and connect that to increase the number of available USB ports.

4. Connect the power block provided with the signature capture device to the device, then connect the power block itself to an available power outlet.

As with all USB devices, the host computer finds the new device, then identifies and configures it using the driver you installed in Step 1.

Your TL462-HSB is now installed. Now, you must configure the device through Velocity. For more on this, refer to “Configuring Velocity for Capture Devices” on page 107.
Configuring Velocity for Capture Devices

Before you can capture a signature, the signature capture device must first be added to the Velocity Enrollment preferences.

To do this:

1. In Velocity, from the menu tool bar, open Enrollment Manager.
2. In Enrollment Manager, select **Tools > Device Configuration.** The Device Configuration screen appears.
3. Click the **Signature Capture** tab.
4. In the 'Signature Capture Device' section, pick the device type from the 'Device Type' pick list. All currently eligible signature capture devices are listed here.
5. From the 'Serial Port' pick list, select the port to which this device is connected. All ports included in the 'Serial Port' pick list include the computer name in addition to the port name or are designated as USB if the signature capture device is connected via a USB port.
6. Click **OK.**

For more on this, refer to “Enrollment Manager Device Configuration” in Velocity On-Line Help.
For instructions on capturing signatures in Velocity, refer to "Enrollment Manager - How to Capture a Signature" in Velocity On-Line Help.
Card Scanners

Velocity 3.1 has been tightly integrated with several models of ScanShell card scanners. These include:

- ScanShell 800
- ScanShell 800N
- ScanShell 1000
- Intelli-Check DCM

Each of these scanners is easy to install and configure.

The scanner is connected to the computer via the USB port. To connect the reader, do the following:

1. Place the scanner on a flat, firm, solid surface with easy access.
2. Plug the USB interface cable into the USB port of the computer.
3. If not already done, turn on the computer.
   The computer should detect the new scanner. The Add Hardware Wizard appears.

4. Click **Next** and follow the wizard instructions until you are asked to select the driver for the scanners.
5. Click the browse button and navigate to the `Program Files\Hirsch Electronics\Velocity\Drivers\CardScanningSolutions\Drivers` subdirectory.
6. Select the \Drivers subdirectory corresponding to the model of your card scanner.
   The driver appears in the browse window.

7. Click **Add**.
   The driver is installed.

Install the required ScanShell application software as described in your user guide.

Once installed, these scanners can be used within Enrollment Manager to collect card data.
Smart Card Readers

Velocity 3.1 supports several Smart Card readers, including:

- Hirsch Electronics ScrambleSmart™
- Integrated Engineering (©)

The ScrambleSmart is fully integrated with Velocity. Hirsch also provides Integrated Engineering Smart Card reader drivers for these reader models:

- SmartID™
- SmartLOGON™

The reader is connected to the computer via the USB port.

To connect the reader:

1. Install the reader as described in the Smart Card user guide. Make sure the reader has its own power supply.
2. Connect the reader to the special 75-bit pass-thru MATCH™ board using the standard Wiegand wiring.
   For more on this special Hirsch MATCH board, please consult Hirsch sales.
3. Plug a USB interface cable from the USB port on the reader into one of the existing USB ports on the Velocity computer.
4. If not already done, turn on the computer.
The computer should detect the new scanner. The Add Hardware Wizard appears.

5. Click **Next** and follow the wizard instructions until you are asked to select the driver for the scanners.

6. Click the browse button and navigate to the `Program Files\Hirsch Electronics\Velocity\Drivers\IntegratedEngineering\USB Drivers\Version_XXXX` subdirectory.
   
   where `XXXX` is the latest version number Velocity supports.

7. Select the driver corresponding to the model of your Smart Card reader.
   
   The driver appears in the browse window.

8. Click **Add**.
   
   The driver is installed.

   Install the required Smart Card reader software as described in your user guide.

   Once installed, these readers can be used within Enrollment Manager to collect card data.
Installing CCTV Matrix Switchers

Velocity provides the ability to control a CCTV matrix switcher and display a single video signal on the Velocity CCTV Viewer. Before you can control the switcher, you must first connect it to the Velocity server.

Currently, Velocity is designed to work with these matrix switchers:

- American Dynamics 2150
- Burle LTC 8000 series
- Burle LTC 8300 series
- Burle LTC 8900 series
- Panasonic WJ-SX550
- Pelco 6700, 6800, and 9700
- Vicon VPS 1344
- Vicon VPS 1466 series

To connect your matrix switcher to the Velocity server or a standalone Velocity server/client workstation:

1. Install and configure the Spectr im Lite board as detailed in "Installing Video Boards," starting on page 97.
2. Connect your CCTV cameras to the CCTV switcher as described in your CCTV installation guide.
3. Using an RS-232 serial cable, connect an available COM port on the switcher to an available COM port on the Velocity server as shown below:
This is the control signal that will be used by the Velocity CCTV Viewer to manipulate the camera generating the video signal.

4. Purchase a coax cable of the correct distance to reach between the switcher and your Velocity server.

   The cable must have a male BNC connector on each end.

5. Connect one end of the coax cable to one of the Video Outputs ports on the switcher as shown in the following diagram:

   Normally, the dedicated CCTV monitors provided with the CCTV equipment are connected to Video Output 1, 2, and so on. In order to see the video in the Velocity CCTV Viewer, connect the Velocity server or workstation to an unused video output.

   You can only connect the video output to a Velocity client or server that possesses a video capture card (VCC). For instructions on installing a VCC, refer to “Installing Video Boards” on page 97.
If you need more video outputs, you can split a video signal from the switcher using either a signal splitter or a distribution amplifier. (We recommend a distribution amplifier since it maintains the signal strength.)

If there are no spare video outputs, you can use a looped-through output from one of the CCTV monitors; however, if you use one of these outputs, the Velocity CCTV Viewer can only display the images that the attached CCTV monitor displays.

+ **Make sure to enter the correct number of this Video Output while you are configuring the switcher in Velocity. Specify the number in the ‘Output to Video’ combo box on the CCTV Switcher Configuration dialog box.** For example, if you connected the cable to Video Output 3, as shown in the preceding diagram, you would select ‘3’ in this combo box.

6. Connect the other end of this coax cable to the female BNC port on the Spectrim Lite card installed in the Velocity server as shown in the next illustration.

   The cable connector must be male in order to connect to the BNC port correctly.
7. Bring up Velocity and configure the system for CCTV as detailed in the Velocity Help file.

\[\textbf{The Spectrim Lite can support a connection to either the CCTV system via the BNC port, or to the photo capture camera via the } S\text{Video mini-DIN port. However, the two operations cannot be performed at the same time. When capturing photographs in Enrollment Manager, make sure that the CCTV Viewer is not operating and visa versa.}\]

8. After you have configured your CCTV system, shut down the server and reboot it.

If you are using a server-client configuration, shut down the client(s) first, then the server. Reboot the server and then the client(s). This orderly shutdown and restart should prepare Velocity to handle its CCTV tasks in a proper way.
Installing Digital Cameras

CCTV cameras generate analog video signals that require switchers and special analog-to-digital circuitry in order to communicate with and be seen by computer systems. Digital cameras require no such intermediaries. The signals generated by a digital camera use the same binary code as a computer and are therefore easily captured and transmitted by any computer or computer network.

Velocity supports a large assortment of digital cameras. All these cameras should use the TCP/IP network. USB serial cameras do not comply with TWAIN standards and are therefore incompatible with Velocity 3.1.

Network cameras enable a direct connection to any existing network. Using these cameras, a Velocity operator can monitor video from any place that can access the Internet. The greatest advantage of a network camera is the ease with which it can be accessed, since each camera is assigned a unique IP address that enables even a remote operator to instantly address that camera.

A USB camera can supply video to any computer through connection to a USB port. Since almost any computer now possesses at least two of these ports, and has the capability through USB hubs to acquire dozens more, USB cameras are becoming more and more prevalent.
Network Cameras

Velocity uses the well-regarded AXIS® line of network digital cameras. With a built-in Web server, only a network connection is required to configure and use the camera. Operate the Network Camera as a standalone unit or place it anywhere there is a LAN or Internet connection, or an available modem.

Velocity supports two Axis digital cameras:
- Axis 2100 — the basic model
- Axis 2120 — auto focus, motion detection, with built-in support for the Axis 2191 Audio Module

Equipment Required

The Axis Network Camera requires these prerequisites:
- Axis 2100 or Axis 2120 Digital Network Camera
- LAN or Ethernet connection
- One or more networked PCs running Windows
- Hirsch Velocity 2.6 or later

Installation Procedure

The Axis Network Camera connects to a Velocity Workstation through the LAN or Ethernet network and uses the Internet Explorer interface for video and administrative functions.

To connect and configure the Axis Network Camera to your surveillance system, follow the instructions in your Axis camera User’s Guide.

Installing the Audio Module

The Axis 2191 audio module connects to and works with the Axis 2120 Digital Camera. It enables the camera to detect ambient noise coming from a specific site or output audio to connected speakers. Input is achieved either using a small built-in microphone or connected high gain microphones.

To connect the audio module to your camera:
Configuring the Camera for Velocity

While you can view the video generated by the camera from within your browser, it is both easier and quicker to create a link that can open a dedicated camera viewer within Velocity Graphics.

This enables an operator to click a linked camera icon and view the current video directly from the map.

In order to do this, we use one of Velocity’s newest features: Custom Links.

To create a linked video icon in Velocity:

1. Open Velocity.
2. Open Graphics.
3. Create a new drawing, import an existing drawing, or open an existing drawing.
4. Open the Object Library and expand the VIO folder until the Custom Links subfolder appears.
5. Right click the Custom Links subfolder and select the **Custom Link Manager** option.
   
   The Custom Link Component Manager screen appears like this example:

   ![Custom Link Component Manager](example.png)

6. Click **Install**.
The Find Custom Link Component appears like this example:

7. Locate and select the AXISLink.CLO file in the AXIS Camera Link subdirectory. Normally, this file is installed in the Velocity\Add-Ins subdirectory.

8. Click **Open**.

9. The new custom link appears in the Custom Link Component Manager like this example:

10. Close the Custom Link Component Manager.
The Custom Links folder in the Object Library should now contain a new component, AXIS Digital Camera Viewer, like this example:

![Custom Links folder with AXIS Digital Camera Viewer](image)

Notice the new AXIS Digital Camera Viewer custom link is added to the Custom Links folder.

+ Make sure you are in Design Mode (press Ctrl + D) or the custom link won’t show.

11. Drag the AXIS Digital Camera Viewer to the required spot on the map or drawing.

The link appears on the drawing like the following example:

![Drawing with AXIS Digital Camera Viewer](image)

The custom link appears in its default form like this.

12. Click on the link then open the Properties window, if it isn’t already open.
The Properties page looks like this example:

```
13. In the 'Name' field, change the camera name as required.
14. In the 'Custom' field, click the button and the AXIS Digital Camera Properties dialog box appears like this:

15. In the 'Address' field, enter the IP address of the camera without the http:\ prefix.
16. If required, in the 'Caption' field, enter the text you want to appear in the viewer title bar.
17. Click OK.
18. Make any other changes to the properties sheet as required.
19. When you're finished, save the drawing.
20. Switch to Live Mode (Ctrl + D again).
21. Click on the camera link.
```
The camera viewer appears like this example:
Installing DVRs

Digital Video Records (DVRs) are used throughout the security and surveillance industry to record input from video cameras. Either digital or analog video input can be stored. Once stored on the DVR’s hard drive, video can be catalogued and replayed with far greater speed and efficiency than was possible with traditional tape recorders. For this reason, DVRs are replacing tape recorders at a rapid rate.
Installation Procedure

Hirsch currently supports these DVRs/NVRs:

- Integral
- American Dynamics
- American Dynamics VideoEdge NVR
- Pelco
- Mate

Any machine in these product lines that supports the Intellex 4.2 or Velocity SDK 4.1 standard is acceptable.

Before beginning, you should have these components:

- Cameras
- BNC cables
- RS-232 serial cable/Ethernet CAT-5 cable

**Connecting the DVR**

To connect your DVR to your Velocity surveillance system:

1. Arrange your surveillance cameras as required, using the camera installation and setup guides appropriate to the camera manufacturer.
2. Plug one end of a BNC cable to the back of the camera.
3. Plug the other end of the BNC cable to a BNC connector on the back of the DVR, as shown in the following example:

4. Connect the DVR/NVR in either of these ways:
   - Connect the Ethernet cable to an available RJ-45 Ethernet port on the back of the Velocity host PC.
   - Connect the RS-232 serial cable to an available serial port on the back of the Velocity host PC.

5. Connect the other end of the Ethernet or serial cable to the RJ-45 or RS-232 connector on the back of the DVR.

6. Power up the DVR.

   *Each DVR has its own requirements. Where necessary, follow the instructions in your DVR guides to connect cameras and the Velocity host to the DVR.*

### Configuring the DVR

Follow the instructions below to configure the DVR:

1. Follow your DVR’s installation and configuration guide to configure necessary software.
2. Open Velocity at the connected Velocity host PC.
3. Configure the DVR using instructions found in Velocity online help. Generally, if you are using an Ethernet connection, this involves specifying the static IP address for the DVR or NVR device.
Multi-Language Applications

As a Windows program, Velocity supports many languages besides English. To use another language, install your local language version of Windows. If you specify another language, that language appears on all menus and dialog boxes throughout Velocity.

To change the language Velocity uses, use the Regional Settings dialog box in Control Panel like this:

1. From the Windows desktop, select **Start > Settings > Control Panel**.
2. From the Control Panel, double click **Regional Options**. The Regional Options dialog box appears.
3. From the General Tab, select the language you need from both the ‘Your locale’ and ‘Menus and dialogs’ combo box fields.
4. From the ‘Language settings for this system’ section, check the box for each language you need to read and write in.
5. Click OK.

In order to change fields within Velocity from one language to another, you must use the Velocity Customization Manager. You can either change fields on the fly from within Velocity or import customization databases as required.

Once Velocity is customized for a local language, you must configure Velocity in this way.

If this is a Velocity Server or Standalone Workstation:
1. If the SCM icon is not yet displayed in the Windows tray, select Start > Programs > Hirsch Electronics Velocity > Service Control Manager.
   The Service Control Manager (SCM) icon appears in the desktop tray at the lower right corner of the screen.
2. Right click the SCM icon.
3. Select Settings from the pop-up option list.
4. Select Database.
5. Check the “Broadcast Customized Values for Alarms & Events” box.

If this is a Velocity Client:
1. Open Velocity.
2. From the Velocity main menu, select Console > Preferences.
3. Click the General tab.
4. Check the “Access and Enable Customized Values...” box.
Upgrading CCMs

In order to use Velocity 3.1, you must have a CCM installed on each Hirsch controller board in your system with firmware version 7.4.31 or later.

This is done in one of two ways:

- Flash download the new version of the CCM firmware to each existing CCM in your system.
- Replace your existing CCMs with the latest version.

Each procedure is covered here.
Replacing Existing CCMs

Many of you with pre-7.0 CCMs will have to replace the old CCMs on your Hirsch controller boards with the new CCM version 7.4.31 or later CCMs.

To replace your CCM:

1. Ground yourself by touching the controller enclosure or power supply to remove any potential static electricity.
2. Turn all controller system power off by removing connectors for both AC power and the standby battery.
   a. Disconnect the DC battery.
   b. Locate the CCM. The CCM is a separate daughter board like the two shown in these M1N and M2 examples:

   CCM daughter board

   M2 Controller

3. Carefully remove the old CCM. Normally you should be able to do this with your fingers.
   Some CCMs, however, may be secured by two screws. Remove these screws, if present.
4. Find the RAM memory chip which is normally located just to the right of the CCM socket on the controller board.

- If the memory chip is soldered, continue with step 5. The new memory chip onboard the new CCM will assume the duties of the old chip.
- If the memory chip is plugged rather than soldered into a socket, remove it. Use a chip extractor to avoid damaging the motherboard.

+ From the second quarter of 1998 on, most controllers Hirsch sold contained the unsoldered (socketed) RAM memory; if you have this memory type, you MUST remove the memory before installing the new CCM. The new CCM contains replacement memory chips.
5. Install the new CCM daughter board. Line up the pins on the bottom of the CCM with the socket on the controller board then press firmly but carefully until the CCM is seated on the board.

6. Reconnect the AC power then the standby battery.
7. Cold start the controller.
IMPORTANT CCM 7.3.0 OR HIGHER FLASH UPDATE INFORMATION

Before you can flash your current CCM to 7.3.0 or higher, you must first check the BIOS level of the CCM. In order for the 7.3.0 or higher flash update to work properly you must be running a CCM with a BIOS level of 7.1.20 or higher.

If you are running a CCM with BIOS 7.1.8, you will need to replace your CCM since the flash will not work properly and the controller may not reboot if powered off. The CCM BIOS Level currently shipping is 7.4.31. To determine the BIOS level of a CCM, you will need to use the Diagnostic Window found under the Help Menu. To do this:

1. Go to the Help menu on the tool bar and click on the Diagnostic Window option. Click on the RED button on the tool bar labeled Diagnostic Stream. The button will turn green.
2. From the Diagnostic Window, at the Controller list box, select the appropriate controller.
3. Go to the Diagnostic Command list box and select option 1 - Date, Time, Version Number and click the button next to this list box. The controller will display system information in the bottom pane of this window. Please look for the following information and determine the BIOS level of your CCM. (In this example, we were running CCM BIOS 7.2.19. The Firmware version number may be very different than the BIOS number. Please remember to only determine the BIOS Level.)
   (Regular)
   1:24:40 PM 001:001:001 SNET Message 139 Device Info Device Type 3 M2
   1:24:40 PM . ROM Sig. ffffffffffffffffx BIOS=7.2.19 Firmware Date=20041027 Vn. 7.3.01
4. If you are running BIOS Level 7.1.20 or higher you can use Velocity to flash your CCM with 7.3.0 or higher.
Installing Printers

This section provides information on how to install and configure printers for use with Velocity. These include:

- MagiCard® Rio® badge printers
- MagiCard® Tango® badge printers
- Eltron® P420 badge printer
- Reporting printers
- Logging printers

While these instructions may not work for all printers, they should work with the majority of printer configurations since they use standard Windows techniques.
Installing Printers

The Rio badge printer supports single-sided badge printing while the Tango supports double-sided badge printing. Both printers use the same driver.

Velocity also supports an older MagiCard model, Turbo, which may or may not support double-sided printing, depending on the options ordered.

Rio and Tango Badge Printers

Using the cable included with the printer, connect the Rio or Tango printer to the designated port. Both Rio and Tango printers support parallel and USB versions; however, we recommend the USB version since it proves easier to configure.

Simply attach the badge printer to the host PC as described in the printer documentation.

Both Rio and Rio 2 as well as Tango and Tango 2 are supported.

Eltron Badge Printers

Follow the instructions shipped with the printer. This normally involves connecting the standard parallel cable to the connectors on the back of both your Velocity workstation and the badge printer, installing the card cleaning cartridge, and plugging the printer in.

Reporting/Logging Printers

Follow the instructions shipped with the printer. This normally involves connecting a standard parallel cable or USB cable to the connectors on the back of both the Velocity server/workstation and printer.
Configuring Printers

This section discusses two types of configuration techniques. The first procedure should configure all types of printers. The second procedure is specific to Rio/Tango badge printers only.

**Configuring MagiCard and Log Printers**

This technique enables you to configure most types of printers. This includes Turbo, Tango, and Rio badge printers as well as reporting and logging printers.

For information on configuring Eltron 420 badge printers, refer to “Configuring the Eltron P420 Badge Printer” on page 142.

Follow the instructions in your printer’s installation and configuration guide.

Perform the following procedure:

1. From the Windows desktop, select **Start > Settings > Printers**. The Printers dialog box appears.
2. Double click **Add Printer**. The Add Printer Wizard appears.
3. Follow the prompts as shown:

<table>
<thead>
<tr>
<th>At this screen:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local or Network Printer</td>
<td>Select the &quot;Local Printer&quot; radio button if the printer is connected to this computer. Select the &quot;Network Printer&quot; radio button if the printer is connected to the network of which this computer is a part. Click Next.</td>
</tr>
<tr>
<td>New Printer Detection</td>
<td>An error message appears indicating that this printer is not Plug and Play. Click Next.</td>
</tr>
</tbody>
</table>
Select the Printer Port

Select LPT1 if the badge printer is connected to this computer’s parallel port. Select an existing TCP/IP address, if this badge printer is connected to a previously-defined IP address. Click the ‘Create a new port’ radio button then select Standard TCP/IP Port if this printer is connected to a new network port.

Click Next.

Add Printer Wizard

Insert the relevant printer CD into your CD drive then click Have Disk...

- If this is a report/logging printer, insert the Windows setup CD or the specific printer’s setup CD.
- If this is a badge printer, insert the Velocity 3.1 CD #2 or the driver CD that came with the printer.

Install from Disk

Select the CD drive letter then specify the directory where the printer driver resides.

- If this is a Turbo badge printer, find this directory and file: Drivers\Ultra MagiCard Turbo Beta\W2KTurbo.inf or WXPTurbo.inf.
- If this is a Rio/Tango badge printer, find this directory and file: Drivers\Ultra MagiCard Rio - Tango\W2KRio.inf or WXPRio.inf.
- If this is a report/logging printer, select the appropriate driver from the available selections.

Click OK, then click Next and follow the prompts to finish the installation.
If the preceding method did not work, refer to “Next, you must tell Velocity which printer is the badge printer. To do this.” on page -141.

The printer driver is now installed. Next, tell Velocity which printer is the badge printer.

To do this:
1. Open Velocity.
2. From the Velocity menu bar, select **Console > Preferences...**
   The Preferences dialog box appears.
3. Click the **Printers** tab.
4. At the ‘Badge’ field, select the badge printer from the drop-down option list.
5. Click **OK**.

For more on this, refer to Velocity on-line help.

Next, you must tell Velocity which printer is the badge printer. To do this:
1. Open Velocity.
2. From the Velocity menu bar, select **Console > Preferences...**
   The Preferences dialog box appears.
3. Click the **Printers** tab.
   A screen like this appears:

   ![Preferences Dialog Box](image)

   4. At the Badge combo box, select the new badge printer option.
5. Click **OK**.

Only one step remains: adjusting for badge thickness.

**Adjusting Badge Printers for Badge Thickness**

Blank badges can come in many different thicknesses and it is important to gauge the blanks correctly if the badge printer is to work properly.

To adjust the printer to accommodate the thickness of your blank badges:

1. Turn off your badge printer.
2. Open the badge printer top.  
   Inside the printer on the side you will see a level labeled ‘Card Thickness Adjustment.’
3. Move the adjustment lever until it matches the thickness of the blank cards you will be loading into it.
   + **Check the specifications for the blank cards to make sure you are gauging the thickness correctly.**
4. Shut the top and turn on the printer.

For more on using this lever, consult your printer’s *User Guide*.

You are now ready to use the badge printer.

**Configuring the Eltron P420 Badge Printer**

Before you can run the Eltron P420 badge printer, you must first install the correct printer driver for it.

To do this, perform the following procedure:

1. Do one of these tasks to install the required Eltron printer driver:
   - Place the Eltron printer CD into your CD drive. It should autorun.
   - Download the most current version of `P420_DRV-v2.exe` from the Eltroncards website. Double click the downloaded executable.

The Elton installation wizard appears.
2. Click to select the language you want to use.
   For purposes of this installation, it is **English**.
3. Select **P420**.
4. Select **Drivers** then click **Next**.
5. Select the printer driver you need then click **Next**.
6. Select the port you want and click **Next**.
   The setup program defaults to **LPT1**: Select this one unless you are currently using LPT1.
   A result sheet appears indicating whether the installation was successful or not.
7. Click **Quit**.
   The driver is now installed.

To check, at Windows desktop, open **Control Panel** and **Printers and Faxes**. If you now see the Eltron P420 printer displayed, you have successfully installed the driver.
This section provides information on how to connect the following device servers to your Velocity server or standalone workstation and configure it:

- Digi One SP (page 146)
- Digi PortServer® TS-16 (page 157)
Digi One SP

The Digi One SP is the newest device server recommended for use with the Velocity system.

This matchbox-sized server enables any device with a RS-232 or RS-485 port to be connected to the Ethernet network using TCP/IP.

In addition to its other virtues, the Digi One SP is extremely easy to connect and configure.

**Prerequisites for the Digi One SP**

Before you connect the Digi One SP, make sure the DIP switch bank, located on the back of the unit, is set correctly. Consult the illustration below:

In other words, if you are connecting the Digi One SP to the SNIB’s RS-232 port, use the default DIP switch setting of 1 UP, all the rest down. If you plan to connect the Digi One SP to the SNIB’s RS-485 port, reset the DIP switches to 3 UP, all the rest down.

One possible reason for switching from RS-232 to RS-485 is to increase the cable distance between the Digi One SP and the first Hirsch controller SNIB. RS-485 can handle cable lengths up to 4000 feet; RS-232 can handle a maximum of 50 feet.
Connecting the Digi One SP

To connect the Digi One SP to your Velocity network:

1. Connect the network LAN cable with the RJ-45 connector to the SP's RJ-45 socket.
2. Do one of these:
   • Connect the Digi One SP's DB9 serial connector to the XBox's RS-232 host port via a serial connector.
   • Using a Hirsch AT-AC and PC-1 cable combination, connect the DB9 end of the AT-AC to the Digi One SP serial port; connect the 4-pin Phoenix terminal block end of the PC-1 to the RS-232 port on a controller's SNIB.
   • Fabricate a cable for RS-485 use between the Digi One SP and the RS-485 port on the SNIB using instructions in “Cable Pin-outs” on page 168.
3. Plug the Digi One SP power supply into the nearest electrical outlet, then connect the cylindrical plug to the power port on the end of the Digi One SP.
   The power port is located next to the Ethernet port.

This enables you to network Hirsch controllers in one of several ways. Two examples are shown below:

**Single Drop**

**Multi-Drop**

You are now ready to configure the Digi One SP.
Configuring the Digi One SP

On initial power-up, the Digi One SP cannot communicate with the devices on either side of it, because it lacks an IP address and other communication settings. This process will provide those values.

+ This configuration assumes you have Digi One SP firmware version 82000774_G or later, a POST of 82000775_F or later, and the latest configuration CD. For firmware version 82000774_C and earlier, your configuration screens look different. Refer to the Digi configurator's on-line help for assistance.

To configure the Digi One SP:

1. Insert the Digi One SP CD into the CD drive of the network server to which this device is connected.

   The CD should auto-start. The main screen appears like this:

   ![Main Screen Example]

   *Note:* All screen examples shown in this manual represent their appearance as of the date of this manual. The appearance of these screens may change when the programs associated with them are updated.

2. Provide these values:

<table>
<thead>
<tr>
<th>Operating System:</th>
<th>Select the operating system you are currently running on this machine.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>Dig One</td>
</tr>
<tr>
<td>Software</td>
<td>Digi Port Authority - Remote</td>
</tr>
</tbody>
</table>

3. Click **Install Software**.
A screen like this example appears:

4. Click **Next**.
   The Select Program Folder screen appears.

5. Click **Next**.
   A screen like this example appears:

6. Click **Finish**.
   The Digi Port Authority Remote program is installed on your computer.

7. At the desktop, select **Start > Programs > Digi > Digi Port Authority Remote**.
   The program detects all Digi devices on the system’s network and displays them in the window as shown above. Initially, the detector can only ascertain the MAC address and the device type unless this network includes a DHCP server.
If DHCP is available, the program can assign an IP address on the fly for each device it detects; otherwise, you must assign an IP address and other network settings as specified below.

+ **If DHCP is used, it must be immediately disabled once the Digi One is configured.**

The Digi Port Authority Remote dialog box appears like this example:

![Digi Port Authority Remote](image)

If more than one Digi device appears in the window, click to highlight the Digi One SP you want to configure.

The Enter Network Password screen appears like this example:

![Enter Network Password](image)

8. Enter the default values at the appropriate fields:
   - **User Name:** `root`
   - **Password:** `dbps`
   - then click **OK**
Check the "Save this password in your password list" box to assign this password the next time you enter.

The Configuration and Management page appears like this example:

This page is generated by the Digi One SP firmware and enables you to configure the device directly.

9. Under the Configuration section, click **Network**.

   The Network page appears like this example:

10. Click to expand the **IP Settings** subpage.
A screen appears like this example:

11. Review and change as required the IP Address, Subnet Mask, and Default Gateway settings.

   Consult your IT department for the correct values.

12. Click to expand the Advanced Network Settings subpage. The Advanced Network Settings fields appear like this example:
13. Make sure these values appear in the corresponding fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet Interface Speed</td>
<td>Auto</td>
</tr>
<tr>
<td>Ethernet Interface Mode</td>
<td>Auto</td>
</tr>
<tr>
<td>TCP Time-To-Live</td>
<td>5 hops</td>
</tr>
<tr>
<td>Probe Interval</td>
<td>10 secs.</td>
</tr>
<tr>
<td>Retransmission Count</td>
<td>10 secs.</td>
</tr>
<tr>
<td>IP Time-To-Live</td>
<td>5 hops</td>
</tr>
<tr>
<td>Probe Count</td>
<td>5</td>
</tr>
<tr>
<td>Enable TCP Keep-Alive</td>
<td>checked</td>
</tr>
<tr>
<td>Idle Timeout</td>
<td>10 secs.</td>
</tr>
<tr>
<td>Store extra byte in TCP Keepalive packets</td>
<td>checked</td>
</tr>
</tbody>
</table>

These changes are shown in the previous example.

14. Review and modify, if required, the Network Service Settings. Make sure the 'Base Socket' field is set to the default value of 2000.

15. Click **Apply**.

If you changed any of the values on the IP settings subpage, a message like this appears:

16. Click **Reboot** to reboot the Digi One SP and assign the new settings.

The Enter Network Password screen reappears.
17. Reenter the default User Name and Password values as shown in Step 8.
   The Configuration and Management screen reappears.
18. Under Configuration, click **Serial Port**.
   The Serial Port Configuration page appears.
19. Click to expand **Basic Serial Settings**.
   A subpage like this example appears:

![Serial Port Configuration](image)

20. Supply these settings for the appropriate fields:
   - If connected to an XBox, the settings are:
     - Baud rate: 9600, 19200, or 38400
     - Data bits: 7
     - Parity: Even
     - Stop bits: 1
     - Flow control: Hardware
If connected directly to a SNIB (RS232 or RS485), the settings are:

- **Baud rate:** 9600 or 19200
- **Data bits:** 7
- **Parity:** Even
- **Stop bits:** 1
- **Flow control:** None

These values will be used to communicate between the DB-9 port on the Digi One SP and the SNIB or XBox.

21. Click **Apply**.
   The new values are written to the selected Digi One SP.
22. Under the Administration heading on the left, click **Security**.
   The Security page appears with three subpages shown:
   - **Administrator Password**
   - **Network Security**
   - **Serial Port Security**
23. Click to expand **Administrator Password**.
   The Administrator Password subpage appears like this example:
24. Provide and confirm a new password that will enable you to personalize access to the Digi configuration screens. We recommend that the default password be changed so that others cannot access this device via the network.

25. Click **Apply**. A password appears prompting you to provide the new password in order to log back onto the Digi One SP. The new password takes effect.

   + **Leave all other settings at their default values.**

For more information on the configuration program, refer to your Digi One SP user documentation.

Finally, make sure you have set your Velocity ‘IP port’ field in the Port Properties dialog box to **2001**. Refer to the Velocity on-line help for more on this.
Digi PortServer TS 16

The PortServer TS 16 efficiently manages Ethernet-to-serial connectivity. It provides up to 16 EIA-232 serial ports.

Velocity administrators and installers use this multi-port device server to connect multiple controllers to a Velocity system via the network.

At a minimum, you can connect up to 16 controllers directly to the PortServer. By adding RS-485 multi-drop connections, you can daisy-chain up to 16 controllers per serial port. The example below shows two possible configurations:

Adding XBoxes and NET*MUXs to the system greatly increases the number of controllers.
Connecting PortServer TS 16

Follow these instructions to set up the PortServer.

1. Connect one end of your network’s CAT-5 Ethernet cable to the Network RJ-45 plug on the far left of your PortServer.
2. Connect the other end of the CAT-5 cable to your network. This RJ-45 network connection can be through a router, hub, or any other plug offering connection to the required network.
3. Connect your DIGI*TRAC Controllers to the PortServer using one of these methods:
   • Connect the PortServer to the XBox RS-232 port via one of the PortServer’s RJ-45 serial connectors. This requires an RJ45-to-DB9 cable.
   • Connect the PortServer ports directly to DIGI*TRAC controllers. This requires an RJ45-to-Molex terminal cable.
   For information on fabricating either of these cables, refer to "Cable Pin-outs" starting on page 168.
4. Plug the PortServer power supply into the nearest electrical outlet, then connect the cylindrical plug to the power port on the end of the PortServer.

Configuring PortServer TS 16

This configuration assumes you have PortServer TS16 firmware version 82000854_J1 or later, a POST of 82000685_F or later, and the latest configuration CD. For earlier firmware versions, the configuration screens will look different. Refer to the Digi configurator’s on-line help for assistance.

To configure the PortServer TS 16:

1. Insert the Digi PortServer TS 16 CD into the CD drive of the network server to which this device is connected.
The CD should auto-start. The main screen appears like this:

2. Provide these values:

<table>
<thead>
<tr>
<th>Operating System:</th>
<th>Select the operating system you are currently running on this machine.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>PortServer TS</td>
</tr>
<tr>
<td>Software</td>
<td>Digi Port Authority - Remote</td>
</tr>
</tbody>
</table>

3. Click **Install Software**.
A screen like this example appears:

4. Click **Next**.
5. Click **Finish**.

The Digi Port Authority Remote program is installed on your computer.

6. At the desktop, select **Start > Programs > Digi > Digi Port Authority Remote**.

The program detects all Digi devices on the system’s network and displays them in the window as shown above. Initially, the detector can only ascertain the MAC address and the device type unless this network includes a DHCP server.

If DHCP is available, the program can assign an IP address on the fly for each device it detects; otherwise, you must assign an IP address and other network settings as specified below.

> **If DHCP is used, it must be immediately disabled once the PortServer is configured.**
The Digi Port Authority Remote dialog box appears like this example:

![Digi Port Authority Remote dialog box](image)

If more than one Digi device appears in the window, click to highlight the PortServer you want to configure.

7. Click **Configure**.

The Enter Network Password screen appears like this example:

![Enter Network Password dialog box](image)

8. Enter the default values at the appropriate fields:

   **User Name:** root
   
   **Password:** dbps

   Check the ‘Save this password in your password list’ box to assign this password the next time you enter.

9. Click **OK**.
Your default browser opens with the main Digi webpage displayed.

This page is generated by the PortServer firmware and enables you to configure the device directly.

10. From the PortServer’s webpage, click on **Network** under **Configure**.
The Network Configuration page appears like this example:

11. Review and change as required the IP Address, Subnet Mask, and Default Gateway settings.
+  Consult your IT department for the correct values.
13. Click the Advanced... link at the bottom of the page.
The Advanced Network Settings page appears like this example:

14. On this page, change these values:

<table>
<thead>
<tr>
<th>Field</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimization</td>
<td>Throughput</td>
</tr>
<tr>
<td>Ethernet Configuration Speed</td>
<td>Auto</td>
</tr>
<tr>
<td>Ethernet Configuration Duplex</td>
<td>Auto</td>
</tr>
<tr>
<td>Probe Count</td>
<td>5</td>
</tr>
<tr>
<td>TCP Time-To-Live</td>
<td>5 secs.</td>
</tr>
<tr>
<td>Maximum Retransmission Timeout</td>
<td>10 secs.</td>
</tr>
<tr>
<td>Probe Interval</td>
<td>10 secs.</td>
</tr>
<tr>
<td>IP Time-To-Live</td>
<td>5 hops</td>
</tr>
<tr>
<td>Enable Keep-Alive</td>
<td>selected</td>
</tr>
<tr>
<td>Keep-Alive Idle</td>
<td>10 secs.</td>
</tr>
<tr>
<td>Keep-Alive Byte</td>
<td>On</td>
</tr>
</tbody>
</table>
These changes are shown in the previous example.

15. **Click **Submit**.

If you have changed any of the IP settings, a message like this appears:

16. **Click **Reboot **to reboot the PortServer TS16 and assign the new settings.**

The Enter Network Password screen reappears.

17. **Reenter the default User Name and Password values as specified in Step 8.**

The Configuration and Management screen reappears.

18. **Click **Ports **under the **Configure **section.**

The Port Configuration Status page appears like this example:

19. **Click the first port name link (such as Port 1) relevant to your installation.**
This should be the port connecting the first controller to your Port 1 connector.
The Port 1 Configuration subpage appears like this example:

20. At the ‘Port Description’ field, enter an optional port name.
21. Supply these port settings for the appropriate fields:
   - If connected to an XBox, the settings are:
     - Baud rate: 9600, 19200, or 38400
     - Data bits: 7
     - Parity: Even
     - Stop bits: 1
     - Flow control: Hardware
   - If connected directly to a SNIB (RS232), the settings are:
     - Baud rate: 9600 or 19200
     - Data bits: 7
     - Parity: Even
     - Stop bits: 1
     - Flow control: None
These values enable communication between the PortServer’s DB-9 port and the connected SNIB or XBox.

22. Click Submit.
   The new values are written to the selected PortServer TS16.

23. Repeat Steps 18-22 for each port you need to configure.

24. Under the Configure heading on the left, locate and click to expand the DHCP option.
   The DHCP page appears.

25. Make sure the Disable DHCP box is checked.

26. Under the Configure heading on the left, locate and click to expand the SNMP option.
   The SNMP page appears.

27. Make sure the Disable SNMP box is checked.

28. Locate and click to expand the Admin option.

29. Click Password.
   The Administration Password page appears.

30. Enter and confirm a new password that will enable you to personalize access to the Digi configuration screens.
   We recommend that the default password be changed so that others cannot access this device via the network.

31. Click Apply.
   A password appears prompting you to provide the new password in order to log back onto the configuration site. The new password takes effect.

+ Leave all other advanced settings at their default values.

For more information on the configuration program, refer to your PortServer TS16 user documentation.

As a final step, open your Velocity program and make sure you have set your Velocity 'IP port' field in the Port Properties dialog box to 2001. Refer to the Velocity on-line help for more on this.
Cable Pin-outs

If you need to fabricate cables for either the Digi One SP or Digi PortServer TS 16, follow these pin-outs below.

**DB9 to RS-232/RS-485 Cable Pin-outs**

For the DB9 to RS232 cable, the Hirsch PC-1 looks like this:

The PC-1 cable comes in a standard 10-foot length; however, if you need to fabricate a longer cable, use the following pin-out diagram:
This requires the following pin-out connections:

<table>
<thead>
<tr>
<th>DB25</th>
<th>Terminal Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

If you plan to fabricate a cable using a DB-9 connector, the pin-out table is shown below:

<table>
<thead>
<tr>
<th>DB-9</th>
<th>RS-232</th>
<th>RS-485</th>
<th>SNIB</th>
<th>XBox</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>RS-232</td>
<td>RS-485</td>
</tr>
<tr>
<td>2</td>
<td>RxD</td>
<td>RxD+</td>
<td>TX</td>
<td>TX+</td>
</tr>
<tr>
<td>3</td>
<td>TxD</td>
<td>TxD+</td>
<td>RX</td>
<td>RX+</td>
</tr>
<tr>
<td>7</td>
<td>RTS</td>
<td>not used</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>CTS</td>
<td>not used</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>DSR</td>
<td>RxD-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>DCD</td>
<td>not used</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DTR</td>
<td>not used</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>N/A</td>
<td>TxD-</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**RJ-45 to DB9 Cable Pin-outs**

If you need to fabricate a cable between the RJ-45 serial connector on the PortServer TS16 and the XBox DB9 or SNIB Molex RS-232 connector, refer to the following chart:

<table>
<thead>
<tr>
<th>RJ-45</th>
<th>Signal</th>
<th>XBox (DB-9) Host Port</th>
<th>SNIB (RS-232)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>GND</td>
<td>5 (GND)</td>
<td>4 (GND)</td>
</tr>
<tr>
<td>4</td>
<td>TxD</td>
<td>3</td>
<td>3 (RX)</td>
</tr>
<tr>
<td>5</td>
<td>RxD</td>
<td>2</td>
<td>2 (TX)</td>
</tr>
<tr>
<td>6</td>
<td>SG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CTS</td>
<td>8 (CTS)</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>DCD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RTS</td>
<td>7 (RTS)</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>DTR</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Diagram showing RJ-45 to DB9 cable connections]
Connecting an Enrollment Station

The Hirsch enrollment station is a device containing an RS-232 connector, a power transformer, and, depending on the version, one of several readers. It is used to enroll one or more cards by reading the card number and sending that information to an attached computer from where the information can be stored, along with other credential information, in the Velocity database.

Hirsch currently offers three types of enrollment stations:

- SMES-H which includes an HID proximity reader
- SMES-M which includes a magstripe reader
- SMES-U which provides the connection and power but allows the customer to insert their own reader, such as biometric, into the box.

An example of the SMES-M enrollment station (SMES-M) is shown below:

The essentials of connecting, configuring, and testing an enrollment station are explained below.
Connecting an Enrollment Station

To connect an enrollment station to a host PC:

1. Connect a cable to the host PC. The PC can either be a client or server. Two types of configurations are supported:
   - Attach a USB-to-RS232 converter (provided by Belkin and other companies) to an available USB port on the PC or an attached USB hub.
   - Attached a serial cable to an available COM (RS-232) port on the host PC
2. Connect the other end of the serial cable to the RS-232 connector on the enrollment station.
3. Connect the power transformer to the enrollment station, then plug it into an available electrical socket.

Testing Enrollment Station Connectivity

1. If Velocity is running, shut it down.
2. At the Windows desktop, select Start > Programs > Accessories > Communications > HyperTerminal.

The Hyperterminal screen appears like this example:

If you are prompted to install a modem, click Cancel.
3. In the Connection Description dialog, enter "Test Enrollment Station" in the Name field and then click **OK**. The Connect to screen appears.

4. At the 'Connect using' combo box, select **Com n** (where \( n \) is the COM Port number to which the enrollment station is connected) then click **OK**. 

5. In the COMn Properties dialog, use the pull-down menus to select the following information. Select OK when finished.
   - Bits per second: 9600
   - Data bits: 8
   - Parity: None
   - Stop bits: 1
   - Flow Control: None

6. Disconnect the enrollment station's power then reconnect it.

7. Verify that the following is displayed in the HyperTerminal window:
   
   MATCH (tm) Reader- Standard
   Copyright (c) 1991 HEC
   All Right’s Reserved. Patent Pending.

   ?

   If this message appears, proceed to **Step 8**.

   If the above message does **not** appear:
   - Check to see if the cable is connected to the correct COM port.
   - Check to see if the cable connected to the MATCH Board P2 connector is properly connected. (The black wire should be towards the edge of the MATCH Board.)
   - Check to see if the cable or adapter is bad.
   - Try another Enrollment Station.

8. With the copyright message displayed, at the "?", type:

   Copyright (c) 1991 HEC

   then press **Enter**.
If the above process was successful, an exclamation point (!) will be displayed. Continue to Step 9. If the above process was not successful, the following will be displayed:

?
?
Guess Again!
?

Repeat Step 8. If the same message appears again, check your connections. If it still doesn’t work, check with Hirsch technical support.

9. With an exclamation point displayed, swipe a card through the Enrollment Station reader slot with the magnetic strip to the right or pass the card in front of the prox reader.

If a string similar to [C123456789] is displayed, the Enrollment Station is working properly.

10. Exit HyperTerminal (File > Exit). A message appears asking you whether you want to disconnect.

11. Click Yes. You are prompted to save the current HyperTerminal session settings.

12. Click No.
Fire Alarm Systems

Velocity can connect to and monitor a fire alarm system using its Central Stations option.

The Central Stations option enables qualified Velocity operators to monitor alarms recorded at one or more alarm panels. In this hierarchy, central station receivers connect one or more alarm panels. Each alarm panel in turn connects to one or more command centers which connect to one or more alarm detection points.

The following illustration shows this system and how it ties in to the Velocity host:
Velocity can neither configure the alarm system nor control (acknowledge or clear) alarms detected by these receivers; it can only monitor those alarms. The clearing and acknowledgement of alarms must take place at the local level, either through the command center or alarm control panel. The configuring of the alarm system is normally handled by local host PCs using device-specific configuration software.

In order to set up Velocity for the Central Stations function, you must:
1. Connect all devices to command centers/alarm control panels.
2. Connect command centers/alarm control panels to the Receiver.
3. Configure the command centers/alarm control panels and their connected devices using proprietary configuration software.
4. Configure communications between the receiver and its connected command centers and control panels using the receiver's configuration software.
5. Connect the Velocity host to the receiver using either serial or Ethernet cable.
6. Configure Velocity to accept the receiver input.

Of these operations, only the last item is the province of Velocity. The task of configuring the Receiver, Command Center(s), and Alarm Control panel(s) is accomplished using proprietary software applications specific to the connected devices.

For example, a Radionics D6500 Receiver is configured using the D6200 programming software. The D9124 Fire Alarm panel is programmed using the RPS software. Individual command centers and control panels are normally configured by a local laptop PC loaded with the requisite software, like RPS.
Installation Procedure

The essential steps you must follow in order to prepare Velocity for communication with fire alarm systems are:

• Connect the alarm centers/panels to their corresponding detection devices (points)
• Connect the alarm centers/panels to the alarm receiver
• Configure alarm panels
• Configure the alarm receivers

In all cases, consult your manufacturer's installation and configuration guides for detailed information.

Only after the device-specific software has defined the devices making up the alarm system can Velocity identify those devices using the same values. Amongst the parameters you must define for the individual devices, these properties are most important before Velocity can engage the alarm system:

• Receiver address (IP or COM port address)
• Accounts
• Areas
• Points

Follow the instructions in the appropriate manufacturer's setup guide to configure the connected alarm devices.

Connecting the Fire Alarm System to Velocity

To connect the fire alarm system to the Velocity host:

1. Do one of these:
   • Using a CAT5 or CAT6 cable, connect one end of the cable to the appropriate RJ-45 connector on the back of the alarm receiver.
   • Using an RS-232 serial cable, connect one end of the cable to an available RS-232 connector on the back of the alarm receiver.

2. Do one of these:
3. Do one of these:
   • If this is a TCP/IP connection, procure the alarm receiver’s MAC address and use the alarm receiver’s installation guide to configure the TCP/IP connection.
   • If this is a serial connection, use an appropriate communication program, like Telnet, to establish communication between the Velocity host PC and the alarm receiver. See your alarm receiver’s installation guide for more information.

### Configuring Fire Alarm System for Velocity

Follow the instructions below to configure the DVR:

1. Consult your fire alarm system’s configuration guide to configure the system for host PC monitoring using the alarm receiver manufacturer’s proprietary software.
2. Open Velocity at the connected Velocity host PC.
3. Configure the Fire Alarm System using instructions on Central Stations found in Velocity online help.
In general, your upgrade path depends on the version of Velocity you are currently running. Follow the chart below:

<table>
<thead>
<tr>
<th>If I am running:</th>
<th>I need to do this:</th>
</tr>
</thead>
</table>
| Velocity v1.0    | 1. Upgrade to v2.0a using the Velocity v2.0a migration utility.  
                  | 2. Upgrade from v2.0a to v2.0b using the Velocity v2.0b Update program.  
                  | 3. Upgrade from v2.0b to v2.5 using the Velocity v2.5 Upgrade CD. Follow the instructions in “Velocity 2.0b to 2.5 Upgrade Wizard,” starting on page 184. |
| Velocity v2.0a   | 1. Upgrade to v2.0b using the Velocity v2.0b Update program.  
                  | 2. Upgrade from v2.0b to v2.5 using the Velocity v2.5 Upgrade CD. Follow the instructions in “Velocity 2.0b to 2.5 Upgrade Wizard,” starting on page 184. |
| Velocity v2.0b   | Upgrade to v2.5 using the instructions in “Velocity 2.0b to 2.5 Upgrade Wizard,” starting on page 184. |
| Velocity 2.5.0.28| 1. Install Velocity 2.5 SP1A.  
                  | 2. Upgrade to v2.6 using the instructions in “Velocity 2.5 SP1A to 2.6 Upgrade Wizard,” starting on page 181. |
| Velocity v2.6    | Upgrade to SP1 and SP2 using instructions in “Upgrading Velocity 2.6 to Velocity 2.6 SP2,” starting on page 183. |
Once you’ve completed these tasks, proceed to the next section.

Older versions of Velocity updates are shipped with their respective upgrades on CD; however, Velocity updates and service packs are available from the Hirsch website (www.HirschElectronics.com).

You can also request the updates on CD by calling or e-mailing Hirsch Sales Department.

<table>
<thead>
<tr>
<th>If I am running:</th>
<th>I need to do this:</th>
</tr>
</thead>
</table>
| Velocity 2.6 SP2 | 1. Insert 3.1 Installation CD  
2. Select the desired option.  
3. See “Installing Velocity” on page 41. |
| Velocity 3.0     | 1. Insert 3.1 Installation CD  
2. Select the desired option.  
3. See “Installing Velocity” on page 41. |
Velocity 2.5 SP1A to 2.6 Upgrade Wizard

The Velocity 2.6 Installation described in Chapter 1 of this guide is designed for clean installs, not for upgrades. To upgrade from the previous version of Velocity, you must purchase the upgrade CD.

+ In order to perform this upgrade, you must have the release version of Velocity 2.5 SP1A already installed on your Velocity system.

Before beginning this process, purchase the Velocity 2.5 SP1A-to-2.6 Update Wizard from Hirsch Electronics.

**To upgrade to Velocity 2.6:**

1. If you are in Velocity, exit it now.
2. Do one of these:
   - If this is a Velocity server or standalone workstation, right click the Service Control Manager icon and stop all Velocity services.
   - If this is a Velocity client, go to the next step.
3. Right click the Velocity Service Control Manager and select **Exit**.
   The SCM disappears from the desktop tray.
4. Insert the Velocity 2.6 Upgrade CD into your CD drive.
   The Auto-start feature should automatically start the update wizard.
   If the update program does not auto-start, open Windows Explorer or the Run program, navigate to the CD drive, and double click on `Update.exe`.
   A splash screen like this appears:
5. Click **Update Velocity 2.5sp1 to 2.6**.
The first Velocity Update Wizard screen appears.

6. Follow these steps:

<table>
<thead>
<tr>
<th>From:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity Update Wizard</td>
<td>Read the instructions then click <strong>Next.</strong></td>
</tr>
<tr>
<td>Installation Type</td>
<td>Select the appropriate radio button and click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>If this is a Velocity Server running on a Windows Server, both options are active. If you are running Velocity on a Standalone Workstation, then only the first option is available.</td>
</tr>
<tr>
<td>SQL Server... Verification Complete</td>
<td>The installer verifies that SQL Server security settings are completed.</td>
</tr>
<tr>
<td></td>
<td>Once this is done, click <strong>Next.</strong></td>
</tr>
<tr>
<td>Checking SQL Configuration Prerequisites</td>
<td>The installer checks for prerequisites.</td>
</tr>
<tr>
<td></td>
<td>Once this is done, click <strong>Next.</strong></td>
</tr>
<tr>
<td>Updating Velocity</td>
<td>The installer updates Velocity. This process updates all database schemas and replaces necessary files.</td>
</tr>
<tr>
<td>Update Complete</td>
<td>Click <strong>Finished.</strong></td>
</tr>
<tr>
<td>Restart message</td>
<td>Remove the CD from your CD drive and click <strong>Yes.</strong></td>
</tr>
</tbody>
</table>

The computer restarts. Now you should upgrade your Velocity 2.6 to SP2 using the following instructions.
Upgrading Velocity 2.6 to Velocity 2.6 SP2

To upgrade from Velocity 2.6 to Velocity 2.6 SP2:

1. Using your browser, go to the Hirschelectronics.com website and select the Technical Services, Downloads & Documents, Velocity -- previous versions, then Velocity 2.6 Enhancements.

2. Download both Service Pack 1 and Service Pack 2.
   Both service packs are self-extracting executable files that are saved to your desktop.

3. Double click the SP1 executable to initiate the installation. Follow the instructions that appear on the screen.
   This update will enable you to update your existing Velocity 2.6 (2.6.0.18) systems to Service Pack 1 (2.6.1.15).

4. Now, install Service Pack 2 using the SP2 executable file.
   This Service Pack will enable you to update your existing Velocity 2.6 SP1 (2.6.1.15) systems to Service Pack 2 (2.6.1.27).

When you open Velocity again, it should be the latest Velocity 2.6.
Velocity 2.0b to 2.5 Upgrade Wizard

All currently-defined settings and values are transferred with the exception of changes made in the Badge & Graphics Designer, Customization Manager, or Report Manager. These are stripped from the upgrade; factory defaults are restored. You must export maps and badge templates as well as reports and customized forms separately.

For exporting graphics as well as reports, refer to Velocity On-Line Help.

Velocity 2.0b to 2.5 Upgrade Preliminaries

Perform these tasks before updating:

- Upgrade all of your controllers’ CCMs to Version 7.2.03 or later. For more on this, refer to “Upgrading CCMs” on page 131.
- Download or purchase the Velocity 2.0b to 2.5 Update Wizard.
- Back up your Velocity database. For instructions on doing this, refer to ‘SQL Data Manager - Backing Up the Velocity Database’ in your Velocity on-line help.
- Archive your alarm and event logs. For instructions on doing this, refer to ‘Task Scheduler - Archive Alarm and Event Logs’ in your Velocity on-line help.
- Make sure you have sufficient disk space available on your computer to accommodate the database conversion. Make sure you have free disk space equivalent to four times the current size of the Velocity database file, Velocity_Data.mdf. For example, if the Velocity_Data.mdf file is 500 MB, make sure you have 2.5 GB of disk space free for the conversion.
  
  You can locate Velocity_Data.mdf in the MSSQL7\Data subdirectory on your hard drive. If your hard drive does not have enough free space, delete unnecessary files and programs to make room.

+ If the database itself is too large, the upgrade will fail regardless of the hard drive space you have available.
Upgrading from Velocity 2.0b to 2.5

To upgrade Velocity V2.0b (Build 1.0.9.60) to V2.5 (Build 2.5.0.28):

1. If you are already in Velocity, exit it now.
2. Do one of these:
   
   - If this is a Velocity server or standalone workstation, right click the Service Control Manager icon and stop all Velocity services.
   - If this is a Velocity client, go to the next step.

3. Right click the Service Control Manager and select Exit.
   The SCM disappears from the desktop tray.
   + Do not stop the SQL SCM.

4. Insert the Velocity 2.5 Upgrade CD into your CD drive.
   The Auto-start feature should automatically start the update wizard.

   If the update program does not auto-start, open Windows Explorer or the Run program, navigate to the CD drive, and double click on Update.exe.

   The update program’s first screen appears. The options that appear on this screen include:

   | Upgrade Velocity 2.0b System | Upgrade this Velocity 2.0b system to Velocity 2.5. |
   | View Documentation | Open Velocity online help and read everything you need to know about using Velocity. |
   | Browse Velocity CD | Review the directories and files included with the Velocity upgrade CD. |
   | Quit | Leave the installer and return to the Windows desktop. |

5. Select Upgrade Velocity 2.0b.
The first Velocity Update Wizard screen appears like this:

![Velocity Update Wizard Screen](image)

6. Click **Next**.
   The wizard detects the current computer’s Velocity settings.
   - If this computer is a Velocity server or stand-alone workstation, a screen like this example appears:

   ![Velocity Installation Wizard](image)

   - If this computer is a Velocity client, go to Step 13.

7. Click one of the radio buttons that appear.

   **Select** | **If this computer is used as:**
   --- | ---
   **Stand-alone system** | A combination server/client or a stand-alone computer.
   **Multi-client system** | A server connected to and communicating with one or more Velocity clients. (The Velocity server can either be the domain controller or a non-domain controller connected to the domain controller.) This requires the computer to be running Windows Server 2003 and must be part of a domain.
The Stand-alone system radio button is the default entry.

8. Click **Next**.

The installer verifies the existence of your SQL Server security settings then checks the SQL configuration prerequisites on this machine. It then updates the SQL programs on your system. This takes four or five minutes.

When the update completes, a prompt like this appears:

9. Click **OK**.

The Velocity Update prompt appears:

10. Click **OK**. The computer reboots.

11. Once Windows desktop has returned, restart the update wizard.

+ **All Velocity services are automatically stopped.**

The first Update Wizard screen appears as in Step 5.

12. Repeat Steps 6–8.
The Wizard copies and installs required Velocity updates. While this happens, you will see a screen like this:

![Wizard Screen]

It takes a few minutes to complete the installation. When the update is completed, a screen like this appears:

![Wizard Screen]

13. Click **Finished**.

The Wizard prompts you to restart your computer:
14. Click **Yes**.

Once the Windows desktop reappears, the new version of Velocity is ready for use. The wizard has now updated Velocity 2.0b to 2.5.
Upgrading to Velocity 3.1 R3

If you have an existing installation of Velocity 2.6 SP2 or Velocity 3.0 on your host machine with either SQL Server 2005 or SQL Server 2005 Express, you can upgrade Velocity without going through the clean install described earlier in this guide.

+ If you plan to use Windows Server 2008 and SQL Server 2008 with Velocity 3.1 R3, we recommend that you migrate to a new machine using the database on your existing machine as the backup for the SQL database.

In general:

<table>
<thead>
<tr>
<th>If I am running:</th>
<th>I need to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity 2.6 SP2 with</td>
<td>Follow the instructions in “Upgrading Velocity</td>
</tr>
<tr>
<td>Windows 2003 or XP</td>
<td>2.6 SP2 to Velocity 3.1 R3,” starting on page</td>
</tr>
<tr>
<td></td>
<td>190.</td>
</tr>
<tr>
<td>Velocity 3.0 with</td>
<td>Follow the instructions in “Upgrading Velocity</td>
</tr>
<tr>
<td>Windows 2003 or XP</td>
<td>3.0 to Velocity 3.1 R3,” starting on page 196.</td>
</tr>
<tr>
<td>Velocity with Windows</td>
<td>Run a clean install. Refer to “Velocity</td>
</tr>
<tr>
<td>2008 and SQL 2008</td>
<td>Installation” on page 40.</td>
</tr>
</tbody>
</table>

Upgrading Velocity 2.6 SP2 to Velocity 3.1 R3

Upgrading from Velocity 2.6 SP2 to Velocity 3.1 R3 must follow a two-step installation process. This is necessary since the SQL Server 7, SQL 2000 Server, or MSDE installed with 2.6 are not compatible with the SQL Server 2008 version installed with Velocity 3.1 R3.

IMPORTANT NOTE: It is highly recommended that you back up your database and files before you upgrade or migrate to the new version.

1. You must first upgrade from version 2.6 SP2 to version 3.1 R2. To do this, see “Upgrading Velocity 2.6 SP2 to Velocity 3.1 R2,” starting on page 191.
+ **Velocity 3.1 R2 files are included on the Velocity 3.1 R3 DVD.**

2. Once you have upgraded to version 3.1 R2, open Windows Explorer and navigate to the DVD drive where the Velocity 3.1 R3 DVD resides.
3. Locate and expand the `Velocity\Updates` directory.
   A file named `Update_for_Velocity_3_1_(KB600).exe` should appear.
4. Double click the `Update_for_Velocity_3_1_(KB600).exe` file.
   The Velocity splash screen appears and the KB600 patch is applied.
5. Follow instructions to complete the update to Velocity 3.1 R3.

### Upgrading Velocity 2.6 SP2 to Velocity 3.1 R2

To upgrade from Velocity 2.6 SP2 to Velocity 3.1 R2:

1. If you are in Velocity, exit it now.
2. Do one of these:
   - If this is a Velocity server or standalone workstation, right click the Service Control Manager icon and stop all Velocity services.
   - If this is a Velocity client, go to the next step.
3. Right click the Velocity Service Control Manager and select **Exit**.
   The SCM disappears from the desktop tray.
4. Insert the Velocity 3.1 R3 DVD into your CD drive.
5. Browse your DVD drive and locate the `Velocity_R2_Installation` folder.
6. Expand the `Velocity_R2_Installation` folder to locate the `Setup.exe` file.
7. Double-click the `Setup.exe` file to begin the upgrade from version 2.6 SP2 to version 3.1 R2.
   The Auto-start feature should automatically start the update wizard.
If the update program does not auto-start, open Windows Explorer or the Run program, navigate to the DVD drive, and double click on Setup.exe.

The Velocity Installer splash screen appears.

8. Follow these steps:

<table>
<thead>
<tr>
<th>From</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity Installer</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Microsoft SQL Server 2005 Backward Compatibility...</td>
<td>Click OK.</td>
</tr>
<tr>
<td>Welcome... SQL Server 2005 Backward Compatibility</td>
<td>Click Next.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click the “I accept...” radio button then click Next.</td>
</tr>
<tr>
<td>SQL Server 2005 Backward Compatibility Setup – Registration</td>
<td>Enter an Admin name and a Company name. Once this is done, click Next.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Click Next.</td>
</tr>
<tr>
<td>Ready to Install the program</td>
<td>Click Install.  The SQL Server 2005 Backward compatibility setup begins.</td>
</tr>
<tr>
<td>Completing... Backward Compatibility Setup</td>
<td>Click Finished.</td>
</tr>
<tr>
<td>SQL Server Native Client Setup</td>
<td>Click Next.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click the “I accept...” radio button then click Next.</td>
</tr>
<tr>
<td>SQL Native Client Server Registration Information</td>
<td>Enter an Admin name and a Company name. Once this is done, click Next.</td>
</tr>
<tr>
<td>From:</td>
<td>Do This:</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Ready to Install the program</td>
<td>Click <strong>Install</strong>.</td>
</tr>
<tr>
<td>Completing the SQL Server Native Client Setup</td>
<td>Click <strong>Finished</strong>.</td>
</tr>
<tr>
<td>SQL Server 2008 Native Client Setup for SQL Server 2008</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click the &quot;I accept...&quot; radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>SQL Native Client Server Registration Information</td>
<td>Enter an Admin name and a Company name. Once this is done, click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Ready to Install the program</td>
<td>Click <strong>Install</strong>.</td>
</tr>
<tr>
<td>Completing the SQL Server Native Client Setup</td>
<td>Click <strong>Finished</strong>.</td>
</tr>
</tbody>
</table>

9. If you have not yet installed .NET Frameworks, perform these steps:

<table>
<thead>
<tr>
<th>From:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity Installation Wizard</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>.NET Framework Welcome</td>
<td>Click the &quot;I have read and accept...&quot; radio button then click <strong>Install</strong>.</td>
</tr>
<tr>
<td>Setup Complete</td>
<td>Click <strong>Exit</strong>.</td>
</tr>
<tr>
<td>Velocity Installer</td>
<td>Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
If you have previously installed .NET Frameworks, skip this step.
If you are using a workstation with Windows XP, go to Step 7.
If you are using another operating system, such as Windows 2003, or have already installed the required hotfix for Windows XP, go to Step 8.

10. To install Windows XP hotfix, perform these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.</td>
<td>To install Windows XP hotfix, perform these steps:</td>
</tr>
<tr>
<td></td>
<td>Hotfix for Windows XP</td>
</tr>
<tr>
<td></td>
<td>If this is an XP installation, this dialog box appears; otherwise, go to Step 7.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>License Agreement</td>
</tr>
<tr>
<td></td>
<td>Click the “I Agree” radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>KB942288-v3 Setup</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Continue</strong>.</td>
</tr>
<tr>
<td></td>
<td>Completing the Hotfix...</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Finish</strong>.</td>
</tr>
<tr>
<td></td>
<td>The computer reboots.</td>
</tr>
</tbody>
</table>

Once the desktop reappears, open Windows Explorer or the Run program, navigate to the DVD drive, and double click on Setup.exe again. The Velocity installer splash screen appears. Go to Step 8.

11. Follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.</td>
<td>Follow these steps:</td>
</tr>
<tr>
<td></td>
<td>Velocity End-User License Agreement</td>
</tr>
<tr>
<td></td>
<td>Click the “I agree...” radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>Install Options</td>
</tr>
<tr>
<td></td>
<td>Accept the “Upgrade to Velocity 3.1” radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>Install Options - Select Role</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>Application Security</td>
</tr>
<tr>
<td></td>
<td>Enter a password and confirm it, then click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>System Inspection</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td></td>
<td>SQL Server</td>
</tr>
<tr>
<td></td>
<td>Accept the &quot;Install a HIRSCH named instance...&quot; radio button then click <strong>Next</strong>.</td>
</tr>
</tbody>
</table>

If a message like this appears:
"You have selected 'Use local accounts' but have logged on to Windows with a domain account"
Click Yes and complete the installation.
Upgrading to Velocity 3.1 R3

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Installation</td>
<td>Make any changes you require then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Application Installation</td>
<td>Make any changes you require then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Prerequisite Gathering</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Install the Tutorials?</td>
<td>Click <strong>Yes</strong> to install the tutorials, or <strong>No</strong> to decline installation of them. The installer now begins the installation process.</td>
</tr>
<tr>
<td>Microsoft SQL Server Management Studio Express Setup</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>License Agreement</td>
<td>Click the “I Agree” radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Registration Information</td>
<td>Enter an Admin name and a Company name. Once this is done, click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Feature Selection</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Ready to Install the program</td>
<td>Click <strong>Install</strong>.</td>
</tr>
<tr>
<td>Completing the Microsoft SQL Server Management Studio Express Setup</td>
<td>Click <strong>Finish</strong>. The database upgrade and migration takes several minutes to complete.</td>
</tr>
<tr>
<td>Installation Complete</td>
<td>Click <strong>Close</strong>.</td>
</tr>
<tr>
<td>Velocity Update</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Update for Velocity 3.1</td>
<td>Click <strong>Start</strong>. The updates are installed. This can take several minutes. When it completes, click <strong>Close</strong>.</td>
</tr>
</tbody>
</table>
When you open Velocity again, the new version of Velocity should now appear.

Finally, turn the firewall back on, using the instructions in “Turning On Windows Firewall” on page 85.

**Upgrading Velocity 3.0 to Velocity 3.1 R3**

To upgrade from Velocity 3.0 to Velocity 3.1 R3:

1. Insert the Velocity 3.1 R3 DVD into your CD drive.
   The Auto-start feature should automatically start the update wizard.
   If the update program does not auto-start, open Windows Explorer or the Run program, navigate to the DVD drive, and double click on Setup.exe.
   The Velocity Installer splash screen appears.

2. Follow these instructions:

<table>
<thead>
<tr>
<th>From:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity Installer</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Velocity End-User License Agreement</td>
<td>Click the “I agree...” radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Install Options</td>
<td>Accept the &quot;Upgrade to Velocity 3.1” radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Prerequisite Gathering</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Install the Tutorials?</td>
<td><strong>Click Yes</strong> to install the tutorials, or <strong>No</strong> to decline installation of them.</td>
</tr>
<tr>
<td>Windows .NET Framework Setup</td>
<td>Click the &quot;I have read and ACCEPT...&quot; radio button then click <strong>Install</strong>.</td>
</tr>
<tr>
<td>Setup Complete</td>
<td>The .NET setup is completed. <strong>Click Exit</strong>.</td>
</tr>
<tr>
<td>.NET Framework 3.5 SP1 Setup</td>
<td><strong>Click Restart Now</strong>.</td>
</tr>
</tbody>
</table>
3. Once the desktop reappears, open Windows Explorer or the Run program, navigate to the DVD drive, and double click on Setup.exe again.

4. Follow these instructions:

<table>
<thead>
<tr>
<th>From:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity Installer</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Velocity End-User</td>
<td>Click the “I agree...” radio button then</td>
</tr>
<tr>
<td>License Agreement</td>
<td>click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Install Options</td>
<td>Accept the “Upgrade to Velocity 3.1”</td>
</tr>
<tr>
<td></td>
<td>radio button then click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Prerequisite Gathering</td>
<td>Click <strong>Next</strong>.</td>
</tr>
<tr>
<td>Install the Tutorials?</td>
<td>Click <strong>Yes</strong> to install the tutorials, or <strong>No</strong> to decline installation of them.</td>
</tr>
<tr>
<td>Installation Complete</td>
<td>Click <strong>Close</strong>.</td>
</tr>
<tr>
<td>Velocity Update</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Velocity Update Wizard</td>
<td>Click <strong>Start</strong>.</td>
</tr>
<tr>
<td></td>
<td>The updates are installed. This can take several minutes.</td>
</tr>
<tr>
<td></td>
<td>When it completes, click <strong>Close</strong>.</td>
</tr>
</tbody>
</table>

When you open Velocity again, the new version of Velocity should now appear.

Finally, you should turn the firewall back on, using the instructions in “Turning On Windows Firewall” on page 85.
Modem Setups for Dial-Up

Currently, Hirsch sells and supports two types of modems:

- MultiTech Multi-Modem MT2834 Series (Hirsch #EM9600-DL) for the host end
- Zoom 14.4 Pocket Modems (Hirsch #DM96-10708) for the remote end

Read your modem user guide carefully for installation and configuration instructions.

Before you can communicate successfully, you must first:

1. Configure the host modem in Windows.
2. Connect the MultiTech host modem to an available serial port on the back of the Velocity server or workstation.
3. Connect the Zoom 14.4 remote modem to the required controller.
4. If needed, configure both modems using HyperTerminal.
5. Set up Velocity to communicate with both modems.

Each of these steps is described in the following chapter.
Connecting the Modems

Modems connect the host PC to the SNIB on the remote controller in the following way:

1. Set the MultiTech modem’s DIP switches to this:
   - SW1 UP
   - SW2 UP
   - SW3 DOWN
   - SW4 UP
   - SW5 DOWN
   - SW6 UP
   - SW7 DOWN
   - SW8 DOWN
   - SW9 DOWN
   - SW10 UP
   - SW11 UP
   - SW12 DOWN
   - SW13 UP
   - SW14 UP
   - SW15 UP
   - SW16 DOWN

2. Using a RS-232 serial cable, connect the MultiTech modem to an available COM (serial) port on the Velocity host.

   *If you don’t have an available serial port on your computer, you can install either a serial board, like a DigiBoard, to provide more serial ports, or connect the USB port on your computer to the modem via a USB-to-serial adapter.*

3. Using an RS-232 serial cable, connect the Zoom 14.4 modem to the SNIB board on the Hirsch controller.
   - There are no DIP switches to change on the Zoom modem.
4. Make sure that the SNIB on the first remote controller—the one connected to the modem—is set to Address 1.
To do this, set these switches on the first SNIB:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW7-11</td>
<td>OFF</td>
</tr>
<tr>
<td>SW12</td>
<td>ON</td>
</tr>
</tbody>
</table>

5. Indicate whether this is a dial-up or lease line modem:

- **Dial-Up**: SW3 - ON
- **Lease Line/Hardwired**: SW3 - OFF

SW3 must set to ON for the controller where the modem reside. Leave all the other SNIB switches at their default settings.

You can daisy-chain additional controllers off of this first controller, but the first controller must have its address set to 1.

---

## Modem Setup on Windows

Once physical connections are completed, the modems must be added to the operating system (Windows 2003/XP). To do this:

1. At the Windows desktop, select either **Start > Control Panel** (if this is Windows XP) or **Start > Settings > Control Panel** (if this is Windows 2003).
   - The Control Panel appears.
2. Select **Phone & Modem Options**. The Phone & Modem Options screen appears.
3. Select the **Modems** tab. The Modems page appears.
4. Click the **Add...** button. The Add Hardware Wizard appears.
5. Check the ‘Don’t detect my modem...’ box.
   - This enables you to specify the modem you require without any auto-detection.
6. Click **Next**. The Install New Modem screen appears.
7. From the Manufacturer list, select the manufacturer.
   - If this is the MultiTech mode, EM9600-DL, select **MultiTech Systems**.
   - If this is the Zoom 14.4 modem, DM9600, select **Zoom Telephonics**.
8. From the Modem list, select the model representing the model of this modem.
   - If this is the MultiTech, select **MT2834BA**.
   - If this is the Zoom 14.4, select **14.4 EX**.
   - If you are using another modem, refer to your modem user guide for information.
9. Click **Next**. The COM port selection page appears.
10. Select the COM port to which this modem is connected from the window.
11. Click **Next**. The Wizard concludes the installation.
12. Reboot the computer.

The computer updates the Registry and other files.

If this method does not succeed in enabling the host and remote modems to communicate with each other, you must then use HyperTerminal. Refer to the following section for more on this.

### Configuring Modems using HyperTerminal

Sometimes, modems don’t communicate with the host PC. Either they are configured improperly for the task envisioned, or one modem is configured differently from the other.

The following procedure will help you assess and set both modems with proper communication.

1. At the Windows desktop, do one of these:
   - For Windows 2003, select **Start > Programs > Accessories > Hyperterminal**.
   - For Windows XP, select **Start > All Programs > Accessories > Communications > Hyperterminal**.

The Connection Description dialog box appears.

2. Type in a new connection name, then click **OK**.

The Connect To screen appears.

3. At the ‘Connect Using’ field, select the COM port on your host PC to which your modem is connected.
4. Click **OK**.  
The COM Properties sheet appears.

5. Set communication parameters as shown below:
   
   **Bits per second:** 9600
   
   **Data bits:** 8
   
   **Parity:** None
   
   **Stop bits:** 1
   
   **Flow control:** none

6. Click **OK**.  
The Hyperterminal screen appears.

   + **Click the cursor in this window and enter the AT commands you need.**

7. Enter the commands you need sent down to the modem for configuration.
   
The commands you send depend on the modem you are using. The following sections provide instructions for configuring two types of modems used by Velocity: MultiTech MT2834BA and Zoom 14.4 Pocket modems.

   Consult your modem manual to make sure these AT commands are correct for your modem. If you must use different commands, make sure you:
   
   • disable data compression
   
   • disable error correction
   
   • dial the modem.

Once you’ve verified that the modems connect, it’s time to configure Velocity to understand the modem language. Use the commands in the following two sections to configure the MultiTech and Zoom modem.

### Configuring MultiTech Modems

Follow these instructions for configuring MultiTech modems at the HyperTerminal.
+ "0" is a numeric zero in all the examples that follow.

1. At the cursor, type this instruction:
   \[ \text{AT&F&W0} \]
   and press \textbf{Enter}. This sets modem to factory settings. You will receive an \textbf{OK} response.

2. At the cursor, type:
   \[ \text{AT$SB9600} \]
   and press \textbf{Enter}. This sets the baud rate to 9600. You will receive an \textbf{OK} response.

3. At the cursor, type:
   \[ \text{AT&W0} \]
   and press \textbf{Enter}. This stores settings to user profile 0. You will receive an \textbf{OK} response.

**Configuring Zoom 14.4 Pocket Modems**

Follow these instructions for configuring Zoom 14.4 pocket modems at the HyperTerminal:

+ "0" is a numeric zero in all the examples that follow.

1. At the cursor, type:
   \[ \text{AT&F&W0} \]
   and press \textbf{Enter}. This sets modem to factory settings. You will receive an \textbf{OK} response.

2. At the cursor, type:
   \[ \text{AT&K0} \]
   and press \textbf{Enter}. This disables local flow control. You will receive an \textbf{OK} response.

3. At the cursor, type:
   \[ \text{AT&Q6} \]
   and press \textbf{Enter}. This tells the modem to lock its DTE speed.

4. At the cursor, type:
   \[ \text{AT&W0} \]
   and press \textbf{Enter}. This saves the settings.

If any problems occur, contact your Hirsch representative or Hirsch Technical Support.
Modem Setup on Velocity

Once you have connected the modems you need and configured Windows to use the modem, you can set up Velocity to communicate with the modem.

To do this:
1. Open Velocity. The Velocity main screen appears.
2. In the Administration window’s System Tree pane, expand the DIGI*TRAC Configuration folder until the Dial-Up folder appears.
3. Click to highlight the Dial-Up folder.
   The Add New Location and Modem Pool Settings options appear in the Components pane.
4. Double click the Modem Pool Settings option.
   The Modem Pool dialog box appears like this example:

   ![Modem Pool Dialog Box](image)

   Only those modems currently configured for this computer appear in the window.
5. Check the box of each modem you want to include in this pool, then click OK.
6. In the Components pane, double click the Add New Location option.
The Dialup Location Properties screen appears with the Host Settings page displayed like this example:

![Dialup Location Properties screenshot]

7. Enter the values required to define this modem connection.
   - **Name:** Supply any appropriate text string.
   - **Baud rate:** 9600
   - **Init String:**
   - **Phone number:** Specify the phone number of the remote modem. This is the number the host modem uses to dial up the remote modem.
   - **Redial Attempts:** 4

8. Click **OK**.
   The new connection appears under the Dial-Up folder in the System Tree pane as well as in the Components pane.
   Once you have dialed up and connected to the required controller(s), define each remote controller and its connected devices, you can return to the Dialup Location Properties screen to define the Remote Settings.

9. From the Components pane, double click on the newly-created dial-up location.
The Dialup Location Properties screen appears with the Remote Settings tab activated.

10. Click the **Remote Settings** tab.

The Remote Settings pages appears like this example:

![Remote Settings Example](image)

11. If required, define the settings and characteristics for the remote modem.

   You must configure the remote modem if you plan to provide that modem with dial-in capabilities.

   If you only plan to dial out to remote controllers from the host, you may not need to configure the remote modem.

12. When you’re finished, click **OK**.

Both the host modem and remote modem should now be configured for Velocity.